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► Before reading this User’s Guide 
and returning your registration card, 
please note below the serial number 
of your Gold card (which can be 
found on the back of the card) and 
the version number of the Gold 
software (which can be found on the 
Ad Lib Gold Program Disks). This 
information will be needed when 
calling our Customer Service or 
Technical Support Department. 

Serial Number 20\ _ 

Software Version Number i, o_ 

• WARNING: Your Ad Lib Gold card Is 
packaged in special material designed to 
protect it against static electricity. We 
recommend that you keep it in this 
package until you are ready to install it in 
your computer. Electronic boards can be 
easily damaged with static electricity and 
must be handled with care. Users should 
ground themselves before handling the 
card. Please read the manual before 
beginning installation. 



Copyright 

This manual and the product and programs it describes are 
protected by copyright laws and therefore may not be 
reproduced (except to make a backup copy), in whole or In 
part, whether for sale or not, without written consent from 
Ad Lib Inc. Under copyright law, copying includes 
translation into another language or format. 

The purchaser may use the programs on any computer in 
his or her possession, but only on one computer at a time. 

Ad Lib, Visual Composer, Juke Box and Voice Pad are 
registered trademarks of Ad Lib Inc. Autodesk Animator is 
a trademark of Autodesk, Inc. IBM PC, XT, AT and PS/2 
are registered trademarks of International Business 
Machines Corporation. Tandy is a registered trademark of 
Tandy Corporation. PC/MS-C)OS, Windows and Microsoft 
are registered trademarks of Microsoft Corporation. Mouse 
Systems is a trademark of Mouse Systems Corporation. 

Limited Warranty 

Ad Lib Inc. warrants the Ad Lib Gold Stereo Sound Adapter 
to be free of any defects In materials or workmanship for a 
period of twelve (12) months from the date of purchase. 
Ad Lib Inc. warrants Ad Lib Gold software programs to be 
free of any defects in material or workmanship for a period 
of ninety (90) days from the date of purchase. These 
warranties are limited to the original purchaser of the 
product and are not transferable. 

Ad Lib Inc. will refund, repair or replace any product 
component or documentation, at Its option and at no 
additional charge. If found defective within the warranty 
period. The purchaser is responsible for returning the 
product to Ad Lib Inc., and must provide a dated proof-of- 
purchase and/or have a registered warranty card for said 
product on file with Ad Lib Inc. 

Ad Lib Inc. will not be held responsible in any way 
whatsoever for refund, repair or replacement resulting 
from improper Installation, accident, misuse, or from 
service or modification of the product by anyone other 
than Ad Lib Inc. or an authorized Ad Lib service center. 

Ad Lib Inc. will not be held responsible in any way 
whatsoever for direct, indirect, special, incidental, or 
consequential damages resulting from possession, use. 
Improper Installation, accident, service, modification or 
malfunction of the product. 

This warranty is in lieu of all other warranties, whether oral, 
written, expressed or Implied, including any warranty of 
merchantability or fitness for a particular purpose, and no 
other representation or claims of any nature shall be 
binding on or obligate Ad Lib Inc. 

This warranty gives you specific legal rights. You may 
have other rights according to your locality. 

Warning 

This equipment generates and uses radio frequency 
energy, and if not installed and used properly (i.e. in strict 
accordance with the manufacturer’s instructions), may 
cause interference to radio and television reception. It 
has been tested and found to comply with the limits for a 
class B digital device in accordance with the 
specifications in Subpart B of Part 15 of FCC Rules, which 
are designed to provide reasonable protection against 
such interference in a residential installation. 

This device complies with part 15 of the FCC Rules. 
Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) 
this device must accept any Interference received, 
including interference that may cause undesIred 
operation._ 



Only peripherals (computer input/output devices, 
terminals, printers, etc.) certified to comply with the class 
B limits may be attached to this equipment. Operation with 
non-certified peripherals is likely to result in interference 
to radio and TV reception. Furthermore, the use of a 
non-shielded I/O cable with this device will not enable the 
device to meet the maximum emission limits mandated by 
U.S. federal Jaw. 

There is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause 
interference to radio or television reception (this can be 
determined by turning the equipment off and on), the user 
is encouraged to try to correct the interference by one or 
more of the following measures: 

• Reorient the receiving antenna. 

• Move the computer away from the receiver. 

• Plug the computer into a different outlet so that 
computer and receiver are on different branch 
circuits. 

If necessary, the user should consult the dealer or an 
experienced radlo/televislon technician for additional 
suggestions. The user Is hereby notified that changes or 
modifications not expressly approved by Ad Lib Inc. could 
void the user's right to use the equipment. 

The user may find it helpful to consult the booklet: 
"How to Identify and Resolve Radlo-TV Interference 
Problems”, prepared by the Federal Communications 
Commission. This booklet is available from the U.S. 
Government Printing Office, Washington, DC 20402, 
Stock No. 004-000-00345-4. 

Technical Support 

Ad Lib Inc. is firmly committed to providing the highest 
level of customer service and product support. If you 
experience any difficulties when using our product, or If it 
fails to operate as described, we suggest you first consult 
the User Guide, and then, if you are still in need of 
assistance^jcalLoiirTeGhriical Support Department: 

Telep^6Qne;J4^529-6252 

Hours, Monday toTricTay:" 

• North American Eastern “hme: 10-12 a.m., 2-5 p.m. 
North American Pacific TimV 7-9 a.m., 11 a.m.-2 p.m. 
Greenwich Time: \ 3-5 p.m., 7-10 p.m. 

Notice 

Ad Lib Inc. reserves the right to m 
improvements in the product desc 
any time and without notice. 

ake changes or 
ibed in this manual at 

aT'. 
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Introduction 

Welcome to Ad Lib Gold™ 

Welcome to Ad Lib Gold, the powerful line of 
multimedia audio adapters from Ad Lib Inc. Ad Lib 
Gold is an advanced audio solution for those who 
use all the great new sound-enabled applications for 
business, multimedia, training, education and 
entertainment. 

The tasks you can enhance with Ad Lib Gold are 
countless; 

• Add soundtracks and unique sound effects to 
your multimedia sales presentations to 
motivate or inspire 

• Record voice notes as verbal explanations or 
reminders right into your sound-enabled 
spreadsheet or word processing programs 

• Listen to excerpts from great composers or the 
sounds of battles of yore just by browsing 
through the audio database of a computer 
CD-ROM encyclopedia 

• Enjoy all the amazing new entertainment titles 
with soundtracks specially written for Ad Lib 
Gold 

• Compose your own musical pieces right on 
screen or using a MIDI device 

• Improve your productivity using Ad Lib Gold 
and text-to-speech software to proofread texts 
or spreadsheet figures. 

The applications for Ad Lib Gold are as limitless as 
your imagination! 

This manual provides a complete description of 
Ad Lib Gold hardware and installation for models 
1000 and 2000 and explains how to use the handy 
software Ad Lib has included to help you get the 
most out of your audio adapter. Be sure to read the 
chapters on: 

• Mixer Panel TSR, which controls mixing 
functions such as volume, balance and tone 

• Juke Box Gold™, a music playback program 
that includes a music clip library in a variety of 
styles and that even lets you listen to songs 
you have composed yourself 

• Voice Pad™, an application for recording, 
editing, managing and playing back voice 
memos and voice alarms 

• Soundtrack Synchronization Editor, which 
allows you to time-synchronize computer 
soundtracks to your slide shows or animated 
presentations 
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Introduction 

• Soundtrack Playback Driver, for playing back 
your Sync files created with Soundtrack 
Synchronization Editor 

• Autodesk Animator Playback Utility, for 
synchronizing frames and sounds in 
presentations created with Autodesk Animator 
or Animator Pro 

• Batch File Utilities, for playing back ROL2 and 
Digitized Sound files 

You’ll quickly come to appreciate Ad Lib Gold for its 
unrivalled flexibility and usefulness. And, thanks to 
Ad Lib Gold’s open architecture design, you’ll be 
able to upgrade your audio adapter to keep pace 
with your changing requirements. Ad Lib offers 
three different add-on modules: 

• The Ad Lib PC Telephone Answering System 
(for North America only) — This tiny card and 
software is a complete system for turning your 
PC into a telephone management productivity 
tool. It allows you to record telephone 
conversations and messages right onto your 
hard disk and build your own personalized 
voice mail system. 

• The Ad Lib Surround Sound Module — This 
piggyback card clips right onto your Gold card 
and adds a whole range of unique sound 
enhancements, such as reverb and echo. 

• The Ad Lib SCSI CD-ROM Adapter Kit — This 
piggyback card offers Ad Lib Gold 1000 
owners a convenient upgrade path for adding 
SCSI CD-ROM capabilities to their Ad Lib Gold 
cards. 

For complete information on Ad Lib’s add-on 
products, call us today on our toll-free customer 
service line at 800-463-2686 (North America). 
International purchasers can call Ad Lib at 
418-529-9676 or write Ad Lib Inc., Customer Service 
Dept., 220 Grande-Allee East, Suite 850, Quebec, 
QC, Canada G1R 2J1. 
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Quick Start 

This Quick Start is intended for the experienced PC 
user who has already installed and used various 
hardware and software applications. Do not attempt 
a Quick Start installation if you are not familiar with the 
PC environment: installation errors could occur that 
will be difficult to correct afterwards. This Quick Start 
includes references to the User Guide for those who 
need more complete information on a particular 
hardware or software installation step. 

Installing the Hardware 

Installing the Gold card 

1. Make sure that the on-board jumpers, the 
“game port enable jumper”, the “port address 
jumper” and the “dual joystick selector 
jumpers”, are in the desired position. 

□ See pages 20 and 24. 

2. Plug the Gold card into the computer in a free 
slot as far as possible from the video adapter 
card. 

-t- NOTE: Certain cards, such as video adapters, 
produce high-frequency signals which can interfere 

__^^^^ithJhe_sound£ualit^r^ofJhe_sound_card^^_^^^_ 

Connect the Other Peripherals 

• Plug headphones or external speakers into 
the main audio output of the card, or connect 
the output to the input of a stereo system. 

• Connect your low impedance microphone to 
the microphone input of the card. 

• Connect the output of your stereo source (CD 
player, CD-RQM drive, synthesizer or cassette 
player) to the stereo auxiliary input of the card, 
using a stereo cable. 

• Connect your joystick to the DB-15 game port 
of the card. If you plan to use the MIDI 
interface, connect your MIDI device with the 
Ad Lib adapter cable. 

□ See "Getting Installed: Installing the Hardware”. 

Installing the Software 

Read the README.TXT File 

We suggest that you examine the README.TXT file 
prior to installing the software. This file contains 
information on the latest program updates, and other 
necessary information. 

□ See "Getting Installed: Installing the Hardware”. 



Quick Start 

Installing the Software 

• Insert the Ad Lib Gold Disk 1 into the floppy 
drive, set the current drive to A (or B, 
depending on which drive you are using), and 
type the following command: 

A:\>type readme.txt 

Install Gold Applications and Resources 

• Run the Gold Setup Program by typing the 
following commands: 

A: \>ctrldrv 

A:\>setup 

□ See "Getting Installed: Software Installation and 
Configuration”. 

Test Hardware and Software 

Once installation is complete, run the Test program 
to verify that the Ad Lib Gold hardware and software 
are functioning properly. 

• Go to the directory where you placed the Gold 
Test Program at installation and load this 
program by typing the following command: 

testgold 

□ See "Getting Installed: Testing the Hardware”. 

Using the Gold Card 

Running Gold DOS Applications 

Once the Gold hardware and software are installed, 
you can run any Ad Lib Gold application by 
proceeding as follows: 

1. Set the current directory to the one where you 
placed the Gold programs during the 
installation process. 

2. Load the Mixer Panel TSR program first, which 
serves to control the different sound 
parameters (balance, tone, volume, etc.), by 
typing the following command: 

mixer 

3. Load the program you want by typing the 
corresponding command: 

jukegoid Juke Box Gold Music Playback 
Program 

voicepad Voice Pad Record and 
Playback Program 

stracked Soundtrack Synchronization 
Editor 

strkdrv Soundtrack Playback Driver 
(followed by the Sync file 
name) 

12 



^___Quick_Star^ 

Using the Gold Card 

pi ay an im Autodesk Animator Playback 
program (followed by the .FLI 
file name) 

piayri2 ROL2 Playback batch file 
utility (followed by the .RL2 file 
name) 

pi ay dig! Digitized Sound Playback 
batch file utility (followed by 
the .SMP file name) 

Except for the Mixer Panel TSR, applications offer 
on-line Help containing summarized information on 
how to operate the program and how to use the 
various features. 

Running a Third Party Program 

To run a third party program supporting the Gold 
card, proceed as follows: 

1. Make sure the Ad Lib Gold hardware and 
software are correctly installed and working 
properly. 

2. Install the program or game acco/ding to the 
manufacturer’s instructions, making sure you 
specify the Ad Lib Gold card in the installation 
options, if requested. 

3. Load the Mixer Panel TSR program first, by 
typing the following command: 

mixer 

4. Load the program by typing the appropriate 
command. 

When running a program with the Gold card, you can 
adjust output volume at any time, without opening 
the Mixer Panel, using the following shortcuts: 

f^-fol-fun For increasing output volume. 

f^-ro1-fp~l For decreasing output 
volume. 

□ See “Mixer Panel TSR”. 
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Description of the Hardware 

Functionality 

Your Ad Lib Gold Stereo Sound Adapter is a 
multifunction card with digital recording, playback of 
digitized and synthesized sounds, analog audio 
mixing, MIDI recording and playback, game port, and 
SCSI/CD-ROM interface (optional with Gold 1000 
and included on-board with Gold 2000). 

Digital Recording 

With the Ad Lib Gold card, you can record from; 

• A low impedance microphone, using Voice 
Pad or third party software: 

• An audio tape or a compact disk, using Voice 
Pad or third party software; 

• A telephone, using the optional add-on board 
contained in the Ad Lib PC Telephone 
Answering System. 

Digitized and Synthesized Sound Playback 

With the Gold card, you can play back: 

• Digitized sounds: The Gold card has two 
channels for digitized sounds. These 
channels can be used in a variety of ways, 
such as for voice notes with the Voice Pad 
program, percussion sounds in the Juke Box 
Gold songs, voiceover in Soundtrack Playback 
Driver, or third party software using stereo 
music or music with voiceover. 

• Synthesized sounds: The Gold card has a 
20-voice FM synthesizer which is used for 
Juke Box Gold songs and third party software 
music. 

The sound capability of the Gold card also features: 

• Audio mixing: The internal analog mixer of the 
Gold card controls the volume of various audio 
sources, through programming, such as within 
third parly software, or manually using the 
Mixer Panel (see “Mixer Panel TSR” section). 

• Volume control: The output volume of the 
Gold card is software controlled (see “Mixer 
Panel TSR”). 
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Description of the Hardware 

Functionality 

• Tone control: Bass and treble controls are 
software controlled (see “Mixer Panel TSR”). 

MIDI Recording and Playback 

The MIDI (Musical Instrument Digital Interface) 
interface of the Gold card allows MIDI files to be 
recorded and played back using a MIDI adapter 
cable, any external MIDI instrument and an Ad Lib 
Gold supporting sequencer program. 

Game Port 

The Ad Lib Gold card allows a standard IBM 
compatible joystick to be connected. 

SCSI Interface 

The Gold card SCSI interface (optional with 
Gold 1000 and included on-board with Gold 2000) 
allows a CD-ROM drive or any SCSI type peripheral to 
be connected. 

9 
. SCSI: Small Computer System Interface; a 

standardized hardware/software protocol for 
sending data between computers or computers and 
peripherals. It is especially suitable for transferring 
large volumes of data (such as with hard disks or 

Layout of the Card 

Bracket Connectors 

Ad Lib Gold Stereo Sound Adapters have three 1/8" 
connectors and one DB-15 connector on the 
support brackets, as shown in the diagrams 
(Figures 1 and 2). 

These connectors are: 

• The low impedance microphone input (No. 7), 
for sampling and/or mixing with other audio 
sources. 

• The stereo auxiliary input (No. 8), for 
connecting an external source such as a CD or 
cassette player, a synthesizer or any audio 
source, in order to sample and/or mix with 
other audio sources. 

• The main stereo audio output (No. 9), for 
connecting to standard headphones, 
bookshelf speakers or a stereo system. 

• The Game Port/MIDI connector (No. 10), for 
using a standard PC joystick and/or a MIDI 
device. This requires an optional MIDI cable 
adapter available from Ad Lib. 

16 



Description of the Hardware 

Layout of the Card 

On-Board Connectors and Main 
Components 

Ad Lib Gold Stereo Sound Adapters have on-board 
connectors to support many different options and 
internal/external devices. These connectors are 
shown in the diagrams (Figures 1 and 2). 

These connectors are: 

• On model Gold 2000, the SCSI port connector 
(Figure 2: No. 22), to connect a SCSI device, 
such as a CD-ROM, hard disk or tape backup 
drive. A 50-pin flat cable is provided for 
connecting an internal device. Cabling for 
connecting an external device is optional. 

• On model Gold 1000, the SCSI option 
connectors (Figure 1: No. 20), to snap on a 
SCSI piggyback board. 

• The Surround Sound option connectors 
(No. 1), to connect a Surround Sound 
Module. This module is used to provide 
stereo and depth enhancements. 

• The telephone option connector (No. 2), to 
connect a telephone line interface add-on 
board. This board allows the Ad Lib Gold card 
to be connected to a standard telephone line 
and provides access to various functions, such 
as creating a completely digital telephone 
answering system capable of leaving 

personalized messages for callers and 
recording and playing back messages left by 
callers directly to and from a hard disk, or 
creating an interactive automated telephone 
routing and database navigation station. It is 
also capable of automated dialing. 

• The internal stereo auxiliary input (No. 4), to 
connect a PC internal audio device (such as an 
internal CD-ROM drive) for direct input. This 
connector is in parallel with and has exactly the 
same functions as the external stereo auxiliary 
input connector on the support bracket. 

^ NOTE: It is not recommended to use both the 
external and internal stereo auxiliary input at the 
same time, because this will decrease the volume 

^^^fJhe_auxiliar^_audio^ource^^^^^^^^^^^^^ 

• The PC speaker connector (No. 3), to 
connect the signal of the PC’s internal speaker 
directly to the Ad Lib Gold card, so that it is 
mixed with the other audio signals on the card 
and can be heard through the headphones or 
speakers. 
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Description of the Hardware 

Layout of the Card 

Figure 1: Gold 1000 diagram 

1. Surround Sound option connectors 
2. Telephone option connector 
3. PC speaker connector 
4. Internal stereo aux. input 
5. Power amp and analog mixer 
6. Bracket 
7. Low impedance microphone input (mono) 

8. Stereo aux. input 
9. Main audio ou^t 

10. Game port/MIDI DB-15 connector 
11. Dual joystick selector jumpers {JP2-7) 
12. Port acidress jumper (JP8) 
13. Control chip reset jumper (JP9) 
14. Custom control VLSI chip 

15. Bus cx>nnector 
16. Game port enable jumper (JP1) 
17. 16-bit FM DAC 
18. Professional FM synthesis chip 
19. Sampling 12-bit DAC and MIDI chip 
20. SCSI option connector 
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Description of the Hardware 

Layout of the Card 

Figure 2: Gold 2000 diagram 

1. Surround Sound option connectors 
2. Telephone option connector 
3. PC speaker connector 
4. Internal stereo aux. input 
5. Power amp and analog mixer 
6. Bracket 
7. Low impedance microphone input (mono) 
8. Stereo aux. input 

9. Main audio outout 
10. Game port/MIDI DB-15 connector 
11. Dual joystick selector jumpers (JP2-7) 
12. Port address jump^ (JP8) 
13. Control chip reset jumper (JP9) 
14. Custom control VLSI chip 
15. Bus connector 
16. Game port enable jumper (JP1) 

17. 16-bit FM DAC 
18. Professional FM synthesis chip 
19. Sampling 12-bit DAC and MIDI chip 
20. SCSI chip 
21. SCSI terminator resistors 
22. SCSI cable connector 
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Description of the Hardware 

Layout of the Card 

The On-board Jumpers 

To make it easier to configure the Ad Lib Gold card, 
\we have made the Interrupt lines (IRQ) and DMA 
channels software selectable, thereby keeping the 
amount of jumpers to a minimum. The four remaining 
jumper sets are the game port enable jumper, the 
dual joystick selector jumpers, the port address 
jumper and the Control chip reset jumper. 

o . DMA stands for Direct Memory Access. With DMA, 

a peripheral can access computer memory without 
intervention of the central processing unit (CPU). 
This technique aibws the speed up of overall 

The Gold card jumpers are the following: 

• Game port enable jumper (No. 16) 
This jumper lets the user enable/disable 
Ad Lib Gold’s on-board game port interface. 
The interface should be disabled in cases 
where the user already has a standard PC 
game port interface inside his/her PC, to avoid 
conflicts. 

Jumper setting is shown here: 

Game port enabled Game port disabled 

Figure 3: Game port jumper enabling 

^ NOTE: The jumper is factory set to the game port 
enabled position._ 

• Dual joystick selector jumpers (No. 11) 
These jumpers let the user change the factory- 
set “joystick plus MIDI” option (all jumpers on 
the bracket side, pins No. 2-3) to the “two 
joysticks without MIDI” option (all jumpers on 
the opposite side, pins No. 1-2). All jumpers 
in this selector must be changed to the same 
position, as shown in the following illustrations. 

Single joystick with MIDI Dual joystick option 

option (factory-set) 

Figure 4: Dual joystick jumper selection 
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Description of the Hardware 

Layout of the Card 

• Port address jumper (No. 12) 
This jumper lets the user choose a single or 
double port address for the Gold card. The 
Ad Lib Gold card addresses can be assigned 
by software programming. The default port 
address of the Gold card is 388H and can be 
changed by software in cases where another 
card inside the PC uses the same address, in 
order to avoid conflicts. In the case where the 
software cannot recognize the programmed 
address, the port address jumper is used to 
force the Gold card into answering at both the 
programmed address and at the default factory 
address 388H. 

NOTE: The port address jumper is factory set to 
single port address position (jumper plugged on the 
two upper pins) which enables only one port 
address to be used at a time. 

Control chip reset jumper (No. 13) 
This jumper is used where the programmed 
configuration of the Control chip is lost. In 
some cases, losing the configuration can 
cause the card to use addresses that are 
already in use by other hardware. Changing 
the position of the Control chip reset jumper 
from the two left pins to the two right pins 
disables certain functions of the Gold card that 
could cause hardware conflicts. Once the 
jumper is plugged on the two right pins, 
reconfigure the Gold card to the factory preset 
values by issuing the following command; 

setup /R 

Once the Gold card is reconfigured, replug the 
Control chip reset jumper onto the two ieft 
pins. 

The port address jumper can be changed to 
double port address position (jumper plugged 
on the two lower pins) which forces the default 
address 388H to be used in conjunction with 
any other user-defined one. 

^ NOTE: You do not need to change the position of 
the Control chip reset jumper to issue the command 
setup /R. Change the position of the jumper 
only when the hardware conflicts prevent the 
computer from rebooting. (See “Appendix A: 
Troubleshooting", Problem No. 12, for details.) 
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Description of the Hardware 

Layout of the Card 

Available Interrupt Lines and DMA Channels 

• There are four software selectable interrupt 
lines (IRQ 3,4,5 and 7) on the Gold 1000, and 
four additional choices on the Gold 2000 
(IRQ 10, 11, 12 and 15). 

• DMA channels 1,2 and 3 are software 
selectable on the Gold 1000, and DMA 
channels 0,1,2, and 3 are software selectable 
on the Gold 2000. 

• Interrupt is a cximputer instruction that halts 

program processing momentarily, so that other 
operations can take place. Once this operation is 
finished, the computer resumes the initial program 
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Getting Installed 

System Requirements 

To use the Ad Lib Gold card and the Gold software, 
you need the following: 

1. For the Gold 1000; an IBM PC, XT, AT (286), 
386, 486 compatible computer, PS/2 Model 
25 and 30, or Tandy 1000 (except EX/HX), a 
disk drive (1.2 MB 5 1/4" or 720 KB 3 1/2") 
and 640K of RAM. 

For the Gold 2000: an IBM AT (286), 386 or 
486 compatible computer, a disk drive 
(1.2 MB 5 1/4" or 720 KB 3 1/2") and 640K 
of RAM. 

2. A hard disk. 

3. Graphics adapter, any model. 

4. PC/MS-DOS 3.0 or higher. 

5. Headphones, an external speaker or a home 
stereo system. 

6. A microphone. 

Installing the Hardware 

We suggest that you read this section thoroughly 
before you begin. This will familiarize you with the 
standard installation procedure. 

These instructions are for installing your Ad Lib Gold 
card in your computer. We recommend that you read 
the owner's manual supplied with your computer for 
instructions specific to your model of computer. 

Hardware Configuration Settings 

To install the Ad Lib Gold card, there are two types of 
configuration settings: hardware settings and 
software settings. The Gold card uses software for 
most of the configuration settings (see the sections 
on installation and configuration below). Only three 
hardware settings, made with jumpers, are 
necessary: game port enabling/disabling, dual 
joystick selection and port address. These should 
be made before installing the Gold card in your 
computer. 
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Getting Installed 

Installing the Hardware 

To Set Game Port Enable/Disable Jumper 

The game port enable/disable jumper lets the user 
enable or disable Ad Lib Gold’s on-board game port 
interface. The interface should be disabled in cases 
where the user already has a standard PC game port 
interface inside his/her PC, in order to avoid 
conflicts. To obtain the desired setting: 

1. Locate the jumper for the game port 
enable/disable setting (refer to Figure 1 or 2, 
No. 16). 

2. If your computer does not have a game port, 
make sure that the jumper is over the two right 
pins as shown in Figure 3. This jumper is 
factory set in the game port enabled position. 

3. if your computer has a game port, unplug the 
jumper from the two right pins and replug it 
onto the two left pins as shown in Figure 3. 

To Set Dual Joystick Selector Jumpers 

The dual joystick selector jumpers let the user 
change the factory-set “joystick plus MIDI” option to 
the “two joysticks without MIDI" option. All jumpers in 
this selector must be changed to the same position, 
as shown in Figure 4. To obtain the desired setting: 

24 

• Locate the dual joystick selector jump©''^ 
to Figure 1 or 2, No. 11). 

2. if you wish to use the Gold card's game 

the “single joystick with MIDI option”, 
jumpers in the factory-set position (i-©- 
plugged onto the bracket side of the caro, h 
No. 2-3) as shown in Figure 4. 

3. If you want to use the Gold card’s garrie port in 
the “dual joystick option”, unplug all six 
jumpers and replug them onto the oppo®' ® 
side (pins No. 1—2), as shown in Figure 4. 

To Set Port Address Jumper 

The port address jumper lets the user choose a 
single or double port address for the Gold card. The 
default port address of the Gold card is 388H. It can 
be changed with the Setup program in cases where 
another card inside the PC uses the same address 
as the Ad Lib card. 

The port address jumper is factory set to the single 
port address position which enables only one port 
address to be used at a time. These port addresses 
can be modified by software, it can be changed to 
double port address position, which forces the 
default address 388H to be used in conjunction with 
any other. 
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Installing the Hardware 

To obtain the desired setting: 

1. Locate the jumper for the port address setting 
(refer to Figure 1 or 2, No. 12). 

2. If you wish to use only one port address at a 
time (388H or any other), make sure that the 
jumper is over the two upper pins. This jumper 
is factory set in the single port address 
position. 

3. If you wish to force the default port address 
388H to be used in conjunction with another 
one, unplug the jumper from the two upper 
pins and replug it onto the two lower pins. 

Removing the Computer Cover 

1. Switch off the computer. 

2. Disconnect the power cord and all peripheral 
devices and cables. 

3. Set the computer on a flat, clear surface. 

4. Remove the mounting screws that hold the 
computer cover. 

5. Remove the computer cover. 

Removing the Slot Cover 

1. Choose a free slot as far as possible from the 
video adapter card. 

^ NOTE: Certain cards, such as video adapters, 
produce high-frequency signals which can interfere 
with the sound quality of the sound card. 

2. Remove the screw that holds the slot cover in 
place. 

3. Lift the slot cover to remove it. 

! WARNING: If a screw falls Into the 

computer, you absolutely must remove it 
before switching your system back on. If 
a metal object Is left loose Inside the 
casing of your computer, it may cause a 
short circuit that will damage your 
system. 

Installing the Gold Card 

1. Place the card immediately above the slot 
without inserting it into the socket. 

2. Make sure that the bracket is inserted in the 
groove previously occupied by the slot cover. 

3. Press the card down into the socket. 

25 



Getting Installed 

Installing the Hardware 

4. Put the card’s bracket screw back on and 
tighten it. 

5. Put the computer cover back on and tighten 
the screws. 

6. Reconnect the power cord and other cables. 

Connecting Other Peripherals 

The card is equipped with jacks and plugs for 
connecting various peripherals. These allow 
devices to be connected to: stereo audio output, 
microphone input, line-level stereo audio input, 
MlDI/game port, PC internal speaker and SCSI port 
(Gold 2000 model only). 

Audio Output 

The Gold card is equipped with three 1/8" jacks for 
connecting audio equipment. The main audio 
output is the lowermost of the three jacks, located 
above the DB-15 connector (refer to Figure 1 or 2, 
No. 9). This jack can be connected to headphones, 
external speakers or a stereo system using stereo 
adapters and cables. Model Gold 2000 comes with a 
cable. To avoid distortion when connecting to a 
stereo system, connect the card to an auxiliary-type 
input. 

Microphone Input 

The low impedance microphone input is the 
uppermost of the three audio jacks on the card’s 
bracket (refer to Figure 1 or 2, No. 7). This connector 
lets the audio signal from a standard microphone be 
mixed with other audio sources or to be used as a 
source for sampling sounds. 

NOTE: The microphone input impedance of the 
Gold card is 1 K£2. The microphone should have a 
maximum impedance of 1 KT2 if you do not want to 
lose too much input level due to an impedance 
mismatch. 

Stereo Auxiliary Input - External Connector 

The external stereo auxiliary input connector is 
located in the center of the three audio jacks on the 
card’s bracket (refer to Figure 1 or 2, No. 8). This 
connector lets audio signals from a stereo source 
(such as a CD player, CD-ROM drive, synthesizer or 
cassette player) be mixed with the other audio 
sources or to be used as a source for sampling 
sounds. 
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! WARNING: To avoid distortion, It Is 

Important to keep the audio level of the 
device you are connecting to this input 
Jack at low volume and to adjust the 
volume using the software controls 
explained in the next section. Also, 
make sure that you are using the 
auxiliary output of the device you are 
connecting to the card, instead of using 
the speaker output which would overload 
the card’s amplifier._ 

Stereo Auxiliary Input - Internal Connector 

As mentioned in the “Description of the Hardware; 
Layout of the Card” section, there is an internal 
connector (refer to Figure 1 or 2, No. 4) for 
connecting the audio output of an internal CD-ROM 
drive. This connector is electrically in parallel with the 
external stereo auxiliary input connector. Thus, to 
obtain good sound results, you may only use one of 
these at a time. 

MIDI/Game Port 

The Ad Lb Gold card features a standard DB-15 
connector at the bottom of its supporting bracket 
(refer to Figure 1 or 2, No. 10). This connector lets 
the user connect one of the following three optbns: 

1. An IBM compatble joystick. 

2. A MIDI device. (This requires an adapter 
cable.) 

3. Dual joystick. (This requires a special adapter, 
which is usually supplied by the joystick 
manufacturer. — See Figure 4 for related 
jumper settings.) 
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Software Installation and Configuration 

The running and using of the Ad Lib Gold card 
drivers and programs require hard disk space of 
approximately 3 megab^ies. They must be installed 
onto the hard disk following a precise procedure. 
For this purpose, the Gold software package 
includes a special Setup Program. This program 
enables you to install the drivers and all associated 
programs, to configure your Ad Lib Gold card and to 
change the hot keys used by Mixer Panel and ROL2 
Playback TSRs. 

Using the Setup Program 

The Ad Lib diskettes are not copy-protected. We 
recommend that you make a back-up copy before 
installing Gold software. Put the originals away in a 
safe place. This way, if a diskette is lost or damaged, 
you will have a replacement. We suggest that you 
use the DISKCOPY command. (For all details 
concerning the copy commands, refer to your DOS 
manual.) 

To Load the Setup Program 

To load the Ad Lib Gold Setup Program; 

1. Insert the Ad Lib Gold disk 1 into the floppy 
drive. 

2. Set the current drive to A (or B, depending on 
the drive you are using). 

3. Load the Setup program by typing the 
following command at the DOS prompt: 

A:\>setup 

When the program opens, a window entitled 
“Installation Notes” introduces you to the Setup 
Program and its basic commands. To activate a 
command, use one of the following methods: 

1. Using the Tab key: Scroll and choose the 
command you want with the |Tab | or -iTab | 
keys. 

2. Using the keyboard shortcuts: To activate the 
command you want, press the iQit I key and the 
letter highlighted in its name. 

3. Using a mouse: To activate the command you 
want, click on it with the mouse. 

Two main buttons are displayed at the bottom of 
each screen; <Cancel> and <Continue>. 

Activating the <Continue> button in the Installation 
Notes introductory screen makes the Setup Program 
open the Main Selection menu (see Figure 5). 
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1 
Fop a flpst-tlnc Instailatlon you nust first copy the prograws aiul t 
driucrs to your hard disk. 

tri 

You should then configure the Ad Lib Gold card. 

i 

Please select an Installation procedure: 

< 1 - Copy Progra*s and Drivers to Hard Disk > 

< 2 - Configure the Card and Driucrs > 

< 3 - TSR Hot Keys > 

< i - Quit the Setup Progran > 

< Cancel > 
-- 

Figure 5: Setup Program’s Main Selection menu 

This menu lets you choose and access the four 
following submenus: 

1. Copy Programs and Drivers to Hard Disk 

2. Configure the Card and Drivers 

3. TSR Hot Keys 

4. Quit the Setup Program 

To Cancel the Setup Process 

At any moment, you can interrupt the setup process 
by clicking on the <Cancel> button at the lower left 
corner of the screen, or by pressing the key. 

Doing this will abort the setup and cancel the steps 
you have made. The changes you made are not 
saved in permanent memory on the card. When you 
reboot your system, these changes will not be 
restored. So, if you have a problem after making a 
change, just reboot your system. 

^ NOTE: Certain elements cannot be reversed and 
will remain installed, such as copied files. To 
cancel the entire operation, it is necessary to re-run 
the Setup Program and reverse the corresponding 
steps, or delete the copied files. See Appendix B 
for a list of the installed files. 

To Continue the Setup Process 

In the setup process, activating the <Continue> 
button lets you close the current dialog box and 
access the next step. Doing this will initiate the 
changes you made in this dialog box, if there were 
any. 

To Answer Program Questions 

During each step of the setup procedure, you will be 
asked to choose between different options or to 
enter answers in edit fields. The program suggests 
an answer that will be correct in most situations. You 
can use this default, or enter your own answer. 
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T 

Configuration Environment Variabies 

A special environment variable, called “GOLD” is 
used by the software to recognize the base address 
of the Gold card. When the card is relocated by the 
Setup program, the program automatically modifies 
the environment variable in the AUTOEXEC.BAT 
file. 

To change the GOLD environment variable, type the 
following command, which should be preferably put 
in the AUTOEXEC.BAT file: 

SET GOLD = XXX 

Where xxx is the hexadecimal value of the Gold 
card base address (Control chip address). 

When the GOLD environment variable is not 
defined, the programs assume a default base 
address of 388H. 

Another environment variable, called “GOLDPATH” 
is used by some software (the ROL2 Playback TSR, 
for example) to determine the location of the data 
files (.SMP, .BNK and .EQU files). 

To change the GOLDPATH environment variable, 
type the following command, which should be 
preferably put in the AUTOEXEC.BAT file: 

Where pathi and path2 are directories where 

data files can be found. 

When the GOLDPATH environment variable is not 
set, the applications look for the data files in the 
directory they were started from. 

SET GOLDPATH = pathl ; path2 ; 

30 



Getting Installed 

Testing the Hardware 

Testing the Hardware 

The Ad Lib Gold Test Program, which is supplied 
with the Gold software, enables you to verify that the 
Gold card is functioning properly. These tests are 
not only used to test the Ad Lib hardware, but also to 
test the connections to all associated peripherals 
(MIDI ports, joystick, SCSI, etc.). 

Preparing the Test Program 

Prior to running the Test Program: 

1. Make sure that the Gold card is properly 
installed. If necessary, refer to the section 
“Installing the Hardware”. 

2. Connect headphones, a speaker or stereo 
system to the audio jack. 

3. Connect the peripherals you plan to use with 
the Gold card. 

4. Turn on your computer. If it is already on, we 
recommend resetting it. 

Loading the Test Program 

To load the Test Program: 

1. Make the directory where you placed the Gold 
software the current directory. For example: 

C:\>cd gold 

2. Load the Test program by typing the following 
command at the DOS prompt: 

C: \GOLD>test 

When the program opens, a first window entitled 
“Installation Notes” introduces you to the Test 
Program and its basic commands. Two main buttons 
are displayed at the bottom of each screen: 
<Cancel> and <Continue>. 

Before each test, the program will explain what the 
test does. It will also point out the procedure to 
follow to complete the test. This information is 
shown at the top of each test screen. To see the 
whole text, click on the scroll bar with the mouse, or 
select the scroll bar with the |Tab | key and use the 
vertical arrow keys ((O and Q). 

If a test does not succeed, a message will appear 
giving probable causes and solutions. 

To Continue the Test 

The <Continue> button lets the user access the 
next step of the test. 

To Cancel the Test and Exit the Program 

When all tests are finished, or anytime within the test 
procedure, you can exit the Test Program and return 
to DOS by activating the <Cancel> button. 
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Choosing Test Options 

Clicking on the <Continue> button in the Installation 
Notes introductory screen opens the Selection 
Panel dialog box (see Figure 6). This dialog box 
presents the list of the tests you can execute: 

• Configuration 

• Audio 

• SCSI Interface 

• Timers 

• FM Sound 

• Joystick 

• MIDI Interface 

• Sampling and Playback 

• Telephone 

• Mixer 

Some of these options may be grayed to indicate 
that they are disabled depending on the available 
hardware. Checking off any of these check boxes 
will let you access the corresponding tests. 

The options can be selected by using one of the 
following methods: 

1. Using the Tab key: Scroll and choose the 
option you want with the Tab key fiTab | or 

or the arrow keys ((3 or (3)- 

2. Using the keyboard shortcuts: To select the 
option you want, press the (3 key and the 
letter highlighted in its name. 

3. Using a mouse: To select the option you want, 
click on it with the mouse. 

M Lib Gold Text rrogrM 
i3CICl»L10S A AQCl 

1 
The Text Faxel dialog Wxx prexcvtx a llxt at the textx i;ou can do. t 

Select AX nany textx ax goA waat And then click on the < Continue > 
button. 1 

1 
1 

111- ConfifurAtlon 116- Joyxtlck 

[ ] Z - Audio (17- niDI Interface 

[ ] 3 - SCSI iBterfAce [18- Sanpllng and FlagUck 

[It- TIncrx [19- Telephone 

[ ] 5 - m Sound [IN- Nlxcr 

< Cancel > < Continue > 

Figure 6: Test Program’s Selection Panel 

Select the option you wish to test and then activate 
the <Continue> button. You can also test several 
options in a row by selecting the options you want 
and activating the <Continue> button. Any test can 
be executed more than once if desired. 

Each test panel displays information on the test 
currently being performed and describes the 
problems and solutions which may be encountered 
during the test. 
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Mixer Panel TSR 

The Ad Lib Gold cards (models 1000 and 2000) have 
an on-board analog mixer that permits the volume of 
different audio sources to be controlled, as well as 
overall output volume, balance and tone. These 
features can be accessed using the Mixer Panel 
TSR. 

The Mixer Panel TSR is a program that allows you to 
set the different sound parameters of the Ad Lib 
Gold card at anytime and from within any application. 
This memory resident program includes three 
different control windows: 

1. Sound Parameters 

2. Sub Mixer 

3. Surround Features 

9 
• TSR stands for Terminate-and-Stay Resident 

program, which is also called memory resident 
program. It is a utility program designed to remain 
in the computer’s memory at all times after hading 
so the user can activate it with a keystroke at any 
time, even while running another program. For more 

__informationonJfSRs^_see^A££endix^^^^^^^^_ 

Loading the Mixer Panel TSR 

To load the Mixer Panel TSR, set the current 
directory to the one where you placed the Mixer 
Panel at installation and type the following command: 

mixer 

^ NOTE: This command can be placed in a batch file 
so that it is loaded automatically. See your DOS 
user guide for details._ 

When the program is loaded, it will display a message 
indicating that the program has been successfully 
loaded. It will also indicate which keys must be used 
to activate the Mixer Panel. 

The Mixer Panel window will not open upon loading 
and has to be activated as explained in the next 
section. If you want the Mixer Panel window open 
upon loading the program, you can use the option 
“/a” with the loading command. To do this, go to 
the appropriate directory and type the following 
command at the DOS prompt: 

mixer /a 
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Activating the Mixer Panel Using the Mixer Panel 

(^-(3-(ED are the default activation keys. (In order 
to avoid conflicts with other programs, you may 
change the last key in the combination of keys used 
to activate the Mixer Panel by using the Setup 
program.) To activate the Mixer Panel, press all of 
the activation keys down at the same time and 
release them. Upon releasing the keys, the main 
Mixer Panel window will appear as shown in 
Figure 7. 

This TSR can be activated at any time with 
applications supporting the Ad Lib Gold. The screen 
will be returned to its original state and mode when 
you exit the Mixer Panel window. 

NOTE 1: If you use a Hercules card with a MGA 
monitor, the Mixer Panel can be activated only in 
text mode. If you activate the Mixer Panel while in 
graphics mode, this may cause problems with your 
system. 

^ NOTE 2: The Mixer Panel cannot be activated in 
some applications which bypass the use of the 
PC’s ROM BIOS to use the keyboard. For this 
reason, the Mixer Panel cannot be activated in a 

^^^^^^^jnjmber^of£om£uterciameSjJor^exam^^ 

Each window of the Mixer Panel displays the 
different parameters and options of the Gold card 
(see Figure 7). To set one of these: 

1. Select the item you want using the vertical 
arrow keys ((O and (LD)- 

2. After this, you can modify the chosen item in 
one of the following ways: 

• decrease or increase the numerical 
parameters and option words one step at a 
time using the horizontal arrow keys 
((ED and (ED ); 

• decrease or increase the numerical para¬ 
meters ten steps at a time using Shift with the 
horizontal arrow keys (fol-fTTI and (ED-(3)i 

• toggle On/Off parameters using the Space 
bar. 

Sound Parameters 

When the program is activated, you will see a window 
appear for setting the basic sound parameters of the 
Gold card. 
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Ad Lib Gold 
Mixer* Panel 

Uolune 69 
Balance 50 - 50 

Treble 40 
Bass 40 

Input level 49 
Output node Linear 

<F1-MSC node> <F2-Sub Mixer> 
<F3—Sur*r*ound> <F4—Saue> <0K> 

Figure 7: The main Mixer Panel window 

Volume 

Sets the master output volume of the board. 

Balance 

Sets the relative volume of the two stereo 
channels. Setting the right channel will 
automatically set the left channel; when you 
increase the right by one unit, the left channel 
decreases by one unit, and vice versa. 

Treble 

Sets the relative loudness of the high 
frequencies of the sound. 

Ba s s 

Sets the relative loudness of the low 
frequencies of the sound. 

Input level 

Sets the gain (input level) of the external 
auxiliary source and of the microphone. 

Output mode 

Sets the output mode of the audio source to 
one of four options: 

• Linear: without any effect on the audio 
source; 

• Pseudo: pseudo stereo effect that can be 
applied when the source is mono; 

• Mono: forced mono effect that can be 
applied when the source is stereo; 

• Spatial: light surround sound effect that can 
be applied when the source is stereo. 

The default setting is Linear. 

<F1-MSC mode/Gold mode> 

Resets the Gold card so it is compatible with 
the original Ad Lib Music Synthesizer Card. 
This might be necessary in cases where a third 
party application that does not properly put the 
Gold card in its default mode for full 
compatibility with the original Ad Lib card. 

<F2-Sub Mixer> 

Opens the Sub Mixer window. 

<F3-Surround> 

Opens the Surround Features window (when 
using the add-on Surround Sound Module). 
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<F4-Save> 

Opens a dialog box that allows the current 
configuration of the Gold card to be saved in 
permanent memory. The saved configuration 
will be in effect when you power on the 
computer. 

M Lib Gold 

The current Mixer Panel values 
uill be saved in permanent 
memory. Type <0K> to proceedj 
or <Esc> to abort. 

<0K> <Esc> 

liiiiiBii 

Figure 8: The Save dialog box 

<OK> ((3 ord^) 

Closes the Mixer Panel main window and 
returns to the current application saving the 
changes you made in the settings. 

Sub Mixer 

Activating the dO key when in the Mixer Panel main 
window will open the Sub Mixer control window. 

Sub Mixer parameters allow the output volume from 
the five different audio sources to be controlled: 

FM 

Sets the output volume of the FM source. 

Sampling 

Sets the output volume of the Sampling 
source. 

Auxiliary 

Sets the output volume of the auxiliary source 
(external or internal). 

Microphone 

Sets the output volume of the microphone. 
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Telephone 

Sets the output volume of the telephone 
(when using the add-on Telephone Module). 

<OK> ((3 ord^) 

Closes the Sub Mixer control window and 
returns to the main Mixer Panel window saving 
the changes you made in the Sub Mixer 
parameter settings. 

Surround Features 

Activating the {rj] key when in the Mixer Panel main 
window will open the Surround Features control 
window. 

dd Lib Gold 

Surround Features 

Surround 
Level 
Effect 

On 
90 

Eecital Hall 

<OK> 

<F3-Surround> <F4-Saue> <0K> 

Figure 10: The Surround Features control window 

^ NOTE: If the Surround Sound Module is not 
installed, the program will display the message 
'■OPTION NOT INSTALLED" and the changes you 

^^jn^<eJoJhe^£arameters^willJiavejio^effectJFi2^2JJ^ 

M Lib Gold 

Surround Features 

Surround 
Level 
Effect 

OPTION NOT 

Off 
90 

Recital Hall 
INSTALLED 

<0K> 

<F3—Surround> <F4—Save> <0K> 

Figure 11: The Surround Features control window 
when option not installed 

Surround 

A toggle On/Off allows the Surround Sound 
option to be enabled or disabled. The default 
setting is Surround Off. 

Level 

Sets the level of the surround sound effect 
produced by the Surround Sound Module. 
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Effect 

Sets the type ot surround sound effect you 
want to enhance the sound ambience 
selected from a variety of presets. 

<OK> (13 or 
Closes the Surround Features control window 
and returns to the main Mixer Panel window 
saving the changes you made in the parameter 
settings. 

Hot Keys 

You can use three combinations of keys to set the 
master volume and to turn On and Off the Surround 
Sound at any time, without opening the Mixer Panel 
window. The program default hot keys are the 
following; 

Increases the master volume 
one unit at a time. 

Decreases the master volume 
one unit at a time. 

(^-[o]-(lD Enables and disables the 
surround sound effect. 

In order to avoid conflicts with other programs, you 
may change the last key in the default combinations 
of keys by using the Setup program. 

Closing the Mixer Panel 

When in the main window of the Mixer Panel, press 
the E3 or (113 key to leave the program and return to 
where you were when the Mixer Panel was activated. 

Removing the Mixer Panel TSR 

When the Mixer Panel TSR is already installed but 
you do not wish to use it, you can unload the 
program with the option “/r”. This option removes 
the Mixer Panel TSR from the computer's memory. 
To remove the Mixer Panel TSR, go to the 
appropriate directory and type the following 
command; 

mixer /r 

Once this command is entered, the program will 
display a message indicating that the Mixer Panel has 
been removed. 
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Juke Box Gold Music Playback Program 

Juke Box Gold is a music playback program specially 
designed to demonstrate the sound capabilities of 
the Ad Lib Gold card itself. It enables you to play 
pre-programmed songs, or those you create yourself 
using the Visual Composer Gold music composition 
program (sold separately). Selected songs can also 
be played at any time while other applications are 
running, with the use of the ROL2 Playback TSR 
commands. 

Loading Juke Box Gold 

Options Help 

lirectory KISDEHO 

I JuJu: Box Gold I 

BUILDaD.RL2 E:SD£J10SGEHRW.RL2 |J 
CAUEGLD.RLZ Gelect> E:\DE?tt\nACHIGLD.RL2 
ERAGLD.RL2 
FLI6HIGD.RL2 
FUGUE2.RL2 
GERRW.RL2 
HIMVGSZ.RLZ 
IK1XJSGLD.RL2 
KRAXEMGD.RL2 
L0RDGLD.RL2 
LUTECOM.RLZ 
HACHIGLD.RL2 [ 

<Re«Jve> 
E:SDEJ10SPOyER2GD.RL2 

Currently playing: 

<Play> <Pausc > <Stop> <Next> <Preuious> 

To load Juke Box Gold, set the current directory to 
the one in which you placed Juke Box Gold at 
installation and type: 

Treble Bass 

Figure 12: The main Juke Box Gold window 

j ukegold 

Once the program is loaded, the main Juke Box Gold 
window will appear as shown in Figure 12. 

This window displays the various menu titles and 
command buttons (see Figure 12). Other possible 
options are contained in the menus. To activate a 
menu or command, use one of the following 
methods: 

1. Using the Tab key: Scroll and choose the 
command you want with the iTab | or -iTab | 
keys. 

2. Using the keyboard shortcuts: To activate the 
menu or command you want, press the fftiH 
key and the letter highlighted in its name. To 
activate a command in an open menu, press 
the highlighted letter. 

39 



Juke Box Gold Music Playback Program 

Loading Juke Box Gold 

3. Using a mouse; To activate the menu or 
command you want, click on the menu or 
button command with the mouse. 

Selecting Songs 

Creating a Selection of Songs 

The main Juke Box Gold window contains two large 
boxes for song selection. The box located at the left 
of the screen displays the contents of the current 
directory. This is a list of files, subdirectories and 
drives through which you can navigate by selecting a 
name and pressing the (3 key, or by double clicking 
with the mouse. The name of the current directory is 
displayed above the box. When the program is 
loaded, the default directory is the directory where 
you placed Juke Box Gold. 

To create a selection of songs, go to any directory 
containing ROL2 files, highlight the file and activate 
the Select command, or press (3i or double click 
with the mouse, for each song you wish to add to the 
selection. As each song is selected, its DOS file 
name will be displayed in the Selection box at the 
right of the screen in its order of selection. You may 
select as many songs as you wish (depending on 
memory capacity), but only from a single directory. 

To Remove Songs from the Selection 

The box at the right of the screen displays the list of 
songs contained in the selection you have made. To 
remove a song from the selection, highlight its name 
and activate the Remove command. 

To Clear a Song Selection 

To remove all the songs contained in the selection at 
once, simply choose the Clear all command from the 
Options menu. 

Playing Music 

To Play Songs 

To play your selection of songs, activate the Play 
button. Each song in the list will be played in order. 

Once the music begins playing, the name of the 
song currently playing is displayed at the bottom of 
the window. 

To Stop Music Playback 

To Stop music playback, activate the Stop button. 
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Playing Music 

To Pause and Resume Music Playback 

To pause music playback, activate the Pause button. 
When the music pauses, the Pause button toggies 
to Resume. 

To continue music playback at the exact place where 
it stopped, activate the Resume button. Once the 
music starts up again, the Resume button switches 
back to Pause. 

To Scan Songs 

To skip to the next song during playback, activate 
the Next button. This will immediately start the next 
song if there are any left in the song selection list. 

To return to the previous song during playback, 
activate the Previous button. This will immediately 
start the previous song. 

Adjusting the Sound 

The Ad Lib Gold card has an on-board analog mixer 
that allows volume and tone controls to be adjusted. 
These features can be accessed from any 
application by using the Mixer Panel TSR program 
(see the section “Mixer Panel TSR”). But you can 
also adjust the sound directly inside the Juke Box 
Gold program. Three sliders located along the 
bottom of the window allow you to adjust volume. 

bass and treble controls while listening to Juke Box 
songs. 

To Adjust the Volume, Bass or Treble 

To adjust one of these three parameters, activate the 
slider you want and use the left and right arrow keys 
(Q and Q) to tower or raise the value of the 
chosen parameter. You can also scroll the indicator 
inside a slider with a mouse. 

To Set the Stereo/Mono Option 

The Gold card output can be set either to stereo 
sound (distinctive signals for the left and right 
channels) or mono sound (identical signals from both 
channels). To change from one to the other, choose 
the Stereo or the Mono option from the Options 
menu. 

Asking for Help 

When you choose the Help command from the Help 
menu, a window opens up on the screen containing 
summarized information on how to operate Juke Box 
Gold and how to use the various features. 
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Exiting the Program 

Exiting the Program 

To leave the program and return to DOS, use one of 
the following methods: 

• Activate the Exit command from the Options 
menu. 

OR 

• Click on the System menu box at the upper left 
corner of the window and activate the Close 
command. 

The playback commands of this TSR can be used at 
any time by the following key combinations: 

CT-iQH-rn 

Plays the selected songs. 

Pauses and resumes the 
music playback. 

Stops the music playback. 

Skips to the next song from 
the selection. 

Returns to the previous song 
from the selection. 

Using the ROL2 Playback TSR 

The music files played by Juke Box Gold are called 
ROL files (.ROL or .RL2). In order to play these 
music files, the application uses a TSR driver, which 
we refer to as ROL2 Playback TSR (see Appendix D 
for more information on TSRs). 

Since TSRs stay in memory while we use other 
programs, the ROL2 Playback TSR allows you to play 
the songs previously selected in Juke Box Gold, 
while using other applications. 

For details on the loading options of the ROL2 
Playback TSR, see “Appendix D: Drivers / TSRs”. 

In order to avoid conflicts with other programs, you 
may change the last key in the combination of keys 
used to activate the above commands by using the 
Setup program. 

When in Juke Box Gold, you should preferably use 
the program playback commands instead of the TSR 
playback commands. 

! WARNING: Do not use the ROL2 

Playback TSR while running other music 
applications, as this will cause conflicts 
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Voice Pad Record and Playback Program 

Voice Pad is an Ad Lib Gold program that enables 
you to record, edit, manage and play back your 
“voice notes”. A voice note can contain the 
following information: 

• recorded digitized sounds, which are usually 
vocal notes entered by the user; 

• a brief written comment added to a vocal note; 

• an alarm time, which is used to trigger a later 
playback of a note. 

Voice notes can be heard using the Playback 
command within the Voice Pad program, or 
automatically by a memory-resident section of the 
program (Alarm driver) which will play back voice 
notes at the time specified in the voice note 
description. Voice notes can be played back daily, at 
a specified time (“Daily Alarm”), or played back only 
once at a specified date and time (“Date Alarm”). 
Voice notes with alarms will be played back, even 
while other applications are being used. 

Loading Voice Pad 

To load the Voice Pad program, set the current 
directory to the one where you placed the Voice Pad 
program during installation, and type: 

voicepad 

When the program is loaded, the main Voice Pad 
window will appear as shown in Figure 13. 

I Ad Lib Uoicc Fad 
File Saapling Options Help 

Kane: [Untitled ] 

Snooze: [5 1 ■!notes 

-fllam- 

(•) Standard HeRO 

( ) Daily alarn 

( ) Date alam 

Alara tine: [HH:nn] [ 1 pa 

Alara date: [YY/mt/DDl 

Actual Tine: 
10:20:^6 aa 

-Record- 

Record tine: 

0.06 seconds 

Figure 13: The main Voice Pad window 

This window displays various menu titles, command 
buttons, options and edit fields. There are other 
possible commands contained in the menus. To 
activate one of them, use one of the following 
methods: 
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1. Using the Tab key: Scroll and choose the 
command or edit field you want with the l^ab | 
key or P^-fTab | keys. 

2. Using the keyboard shortcuts: To activate the 
menu or command you want, press the I 
key and the letter highlighted in its name, or 
press the appropriate function key; to activate 
a command in an open menu, press the letter 
highlighted in its name. Special shortcuts for 
the File commands are also displayed in the 
File menu. 

3. Using a mouse: To activate the menu or 
command you want, click on the menu or 
button command with the mouse. 

Recording a Voice Note 

To Record a Voice Note 

1. Activate the Record command. The Record 
button will then toggle to Stop. 

2. Immediately enter the message you wish to 
make, speaking not too far from the 
microphone (maximum of approximately one 
foot). 

To Stop the Recording 

To Stop the recording, if the recording time has not 
run out, activate the Stop command. The Stop 
button will then return to Record. 

Setting the Recording Parameters 

To Set the Recording Time 

The default recording time is 10 seconds. To 
change the recording time, activate the Sampling 
Duration command from the Sampling menu and 
enter the desired number of seconds from 1 to 999. 

To Set the Sampling Rate 

The sampling rate is the number of sound samples 
per second the program takes. The higher the 
sampling rate (and the higher the bit resolution), the 
higher the quality of the recorded sounds (and the 
higher the amount of disk space required to store 
the voice note). 

You can change the sampling rate to adjust the 
sound quality and amount of disk space your voice 
note uses. The default sampling rate is 
11.025 KHz. To change the sampling rate, open 
the Options menu and choose one of the following 
sampling rates: 22.05, 11.025, 7.35, or 5.5125 KHz 
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Setting the Recording Parameters 

NOTE: The sampling rate of 44.1 KHz is not 
available for recording with Voice Pad. To minimize 
the disk space, voice notes are recorded and 
stored in compressed data format (ADPCM). The 
ADPCM recording sampling rate is limited to a 
maximum of 22.05 KHz. 

To Set the Microphone Gain 

To set the microphone gain: 

1. Activate the Mixer Panel- 

2. Using the vertical arrow keys (Q, O). 
choose the Input level parameter. 

3. Using the horizontal arrow keys (Q. Q)> 
lower or raise the value of the Input level, 
which ranges from 0 to 100 with a default 
setting of 49. We suggest you adjust the 
volume of your recording by proceeding as 
follows: 

• Make a first recording at the default Input 
level of 49. 

• Activate the Playback command to listen to 
the sound quality of the recording. 

• If the sound is distorted, decrease the Input 
level (and/or speak at a greater distance from 
the microphone) and start again. If the 
sound is too weak, increase the Input level 
(and/or speak at a shorter distance from the 

microphone) and start again. 

• Repeat the procedure until you are satisfied 
with the volume of the recording. 

9 
• The microphone gain is the input level of the 

microphone. This parameter directly affects the 
overall volume of your recording. A gain set too low 
will give a recording weak in volume and possibly 
full of parasitic noise. A gain set too high may 

_^^^ntroduce_djstortionJntoJhejecordin£^^^_^__^^ 

Listening to a Voice Note 

To Listen to a Voice Note 

To listen to a voice note, open the voice note (see 
below “To Open an Existing Voice Note”) and 
activate the Play command. The Play button will then 
toggle to Stop. 

To Stop the Playback 

To Stop the playback at anytime, activate the Stop 
command. The Stop button will then switch back to 
Play. 
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Managing Voice Notes 

Managing Voice Notes 

When you create a voice note, the digitized 
recording is stored independently in a .PAD file. For 
each voice note created, other basic information 
(description parameters, alarms, written comment, 
etc.) are stored in a bank file, which contains 
information on a collection of voice notes. 

Voice Pad only recognizes the bank file named 
DIRVOICE.PAD. This file is not delivered with Voice 
Pad. The first time you save a voice note, the 
program will automatically create the DIRVOICE.PAD 
file to store your voice note. From then on, any 
additions and modifications of voice notes will be 
written to DIRVOICE.PAD. 

^ NOTE: DIRVOICE.PAD bank file must remain in the 
same directory as the Voice Pad program 
(VOICEPAD. EXE) for it to work properly. The 
digitized recording .PAD files can be placed in any 

The commands used for managing voice notes are 
found in the File menu. You will use these 
commands often, whether you are saving your work, 
opening a new voice note, finding, or deleting a 
previously saved voice note. 

Saving a Voice Note 

Prior to storing a newly recorded voice note, you 
must first name it. To save a voice note: 

1. Select the Name edit field. 

2. Enter the name you wish, to a maximum of ten 
characters. 

3. Activate the Save command from the File 
menu. 

If the voice note has already been named, it will 
automatically be saved. If not, the program will save it 
by default under the name “Untitled” in the bank. 

Creating a New Voice Note 

To create a new voice note, activate the New 
command from the File menu. This command will 
close any open voice note and will open an empty 
and untitled voice note. 

To Open an Existing Voice Note 

To open an existing voice note: 

1. Activate the Open command from the File 
menu. A dialog box appears on the screen 
listing all the voice notes in the bank. 

2. Select a voice note from this list. 
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Managing Voice Notes 

3. Activate the Open button to confirm your 
choice. This commartd will close any open 
voice note to make room for the new one. 

To Delete a Voice Note 

To delete a previously saved voice note; 

1. Activate the Delete command from the File 
menu. A dialog box appears on the screen 
listing all the voice notes of the bank. 

2. Select a voice note from this list. 

3. Activate the Delete button to confirm your 
choice. This command will automatically delete 
the chosen voice note in the bank. 

Setting the Alarm 

Voice Pad has a built-in alarm clock which allows you 
to set a date and time at which to start playing a given 
voice note. 

To Set a Daily Alarm 

If you set a daily alarm for a voice note, the recorded 
message will start playing at the specified time on 
every day. To set a daily alarm: 

1. Choose the Daily Alarm option in the main 

window. 

2. Activate the Alarm Time edit field. 

3. Enter the hour and minute using the 
appropriate format. 

Doing this will automatically create a “DLY” type 
voice note. 

To Set a Date Alarm 

If you set a date alarm for a voice note, the recorded 
message will start playing at the specified time on the 
specified date. 

To set a date alarm: 

1. Choose the Date Alarm option in the main 
window. 

2. Activate the Alarm Time edit field. 

3. Enter the hour and minute using the 
appropriate format. 

4. Activate the Alarm Date edit field. 

5. Enter the date you wish using the standard 
format (year/month/day), as shown in 
parentheses. 

Doing this will automatically create a “DTE” type 
voice note. 
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Setting the Alarm 

NOTE: If you do not use the alarm option, or if you 
choose the Standard option, this will create a "STD" 

To Set the Snooze Option 

Voice Pad offers a Snooze option that allows a voice 
note with alarm to be repeated following a time delay 
chosen by the user. The Snooze ensures that you 
will not miss a voice note message, in the event you 
are gone while the alarm is playing. 

To set the Snooze time delay for a voice note: 

1. Activate the Snooze edit field located in the 
middle of the main window. 

2. Enter the desired time for the delay between 
the voice note repetitions, from 0 to 60 
minutes. If you do not need snooze, enter a 
time of 0, which means the voicemote has no 
snooze setting. 

If you want to stop an active snooze repetition, 
proceed as follows: 

1. Activate the Stop Snooze... command from 
the Options menu. A dialog box opens 
displaying a list of all currently snoozing voice 
notes. 

2. Highlight the voice note you want to stop 
snoozing. 

3. Activate the Stop Selection command. 

You can also activate the Stop All command to 
stop all snoozing messages at once. 

^ NOTE: Snooze is only effective for one day. 
Message repetitions will stop at the moment the 

^__^^stemdate_chan£es^__^__^^^^_^^^^^_^^ 

The following gives summary information about the 
three types of voice notes Voice Pad creates 
depending on the alarm you specify: 

1. “STD” type, or Standard, voice notes: 

• No alarm has been specified. 

• Voice note will not be played. 

2. “DLY" type, or Daily, voice notes: 

• Daily alarm has been specified. 

• Voice note will be played daily at the time 
specified. 

• Voice note will be repeated until the date 
changes, according to the time delay 
specified in the Snooze setting. 
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Setting the Alarm 

3. “DTE” type, or Date, voice notes: 

• Date alarm has been specified. 

• Voice note will be played at the date and 
time specified. 

• Voice note will be repeated until the date 
changes, according to the time delay 
specified in the Snooze setting. 

The option SORT, located at the bottom right of the 
Open and Delete dialog boxes, allows the displayed 
voice notes to be sorted in one of the following four 
ways: 

• By Record Date 

• By Alarm Date 

• By Name 

To Change the Time Format 
• By Size 

The 12 hour clock is the default format used for the 
alarm. You can change the time format by opening 
the Options menu and selecting the “24 Hour Clock” 
or the “12 Hour Clock” option. 

Adding a Written Comment 

You can also add a brief written comment to your 
voice note. To do this: 

The actual time is displayed in the box at the upper 
right corner of the screen in the chosen time format. 

1. Activate the Note edit field in the main window. 

2. Enter the text you want to a maximum of 
51 characters. 

Setting the Voice Note Display Options 

The option DISPLAY, located at the top right of the 
Open and Delete dialog boxes, allows you to display 
the following three categories of voice notes: 

This written comment will be displayed each time you 
open the voice note. 

• All types of Voice Notes: “STD”, “DLY” and 
“DTE”; 

• Daily Alarm voice notes only: “DLY”; 

• Date Alarm voice notes only; “DTE”. 
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Adjusting the Sound 

Adjusting the Sound Using the Alarm Driver 

The Ad Lib Gold card has an on-board analog mixer 
that allows volume and tone controls to be adjusted. 
These features can be accessed in the Mixer Panel 
TSR, if it is installed. Upon opening the Mixer Panel, 
you can set the different sound parameters, such as 
input level, overall output volume, balance, treble 
and bass. For complete information, consult the 
section “Mixer Panel TSR". 

Asking for Help 

When you choose the Help command from the Help 
menu, a window opens up on the screen containing 
summarized information on how to operate the Voice 
Pad and how to use its various features. 

The Voice Pad program uses three memory resident 
drivers that are necessary for the playback of voice 
notes. The executable files for these drivers are 
CTRLDRV.EXE, WAVEDRV.EXE and 
ALARMDRV.EXE. These drivers must be loaded 
into memory to allow voice note alarms to be played. 
When you use the Voice Pad program, you do not 
have to load these drivers separately. The program 
has a batch file that automatically loads these drivers. 
If you do not wish to use the application program, 
you can load the drivers independently by typing the 
following commands at the DOS prompt: 

drive rs 

ala rmdrv 

Exiting the Program 

While in the main window of Voice Pad, activate the 
Exit command from the File menu or press 
to leave the program and return to DOS. Before this 
command is carried out, a dialog box appears to ask if 
you wish to save the changes you have made to your 
active voice note, if there were any. 

^ NOTE: It may be advisable to load these drivers 
from the AUTOEXEC file, so that they are loaded 
automatically when you start the computer. Place 
the contents of the DRIVERS.BAT file and the 
ALARMDRV command into the AUTOEXEC.BAT 
file. See your DOS user guide for details. 

□ For more information on drivers, see “Appendix D: 
Drivers / TSRs”. 
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Soundtrack Synchronization Editor 

Soundtrack Synchronization Editor is an Ad Lib Gold 
program that allows you to mix and synchronize 
pictures created with a graphic or animation program 
using the various audio sources of the Gold card: FM 
synthesized music, digitized samples (voice and/or 
sound effects) and CD audio. 

Loading Soundtrack Sync Editor 

To load the Soundtrack Synchronization Editor, set 
the current directory to the one where you placed 
the program at installation, and type the following 
command; 

St racked 

When the program is loaded, the Soundtrack Sync 
Editor will appear as shown in Figure 14. 

_|fkl Lib Soundtrack Synchronization Editor | 

File Edit Play Options Help 

[ 
-Cue- 

File Na«c:UHTITLED.S«C 

Cue Kane :[ 
Cue Tine :[ 

Clock 

-Music— 

FREE 

Mane 
Start 

Stop 
Fade In 
Fade Out 

Uolunc 

[ I rVitc (M) 

] 
1 see 
1 sec 

] sec 
] sec 

-Sanplc- 

Mdiac 
Start 

Stop 
Fade In 
Fade Out :t 

UoluMC :[ 

FREE 

:l 
:I 
:[ 
:[ 

] 
1 sec 

] sec 

] sec 
] sec 

I 1 Mute (S) 

CD Audio- 

FREE 

] Track 

Start 

Stop 

Fade la 
Fade Out 

Uolunc 

I 1 Mute (C) 

1 sec 

1 sec 

] sec 
] sec 

Figure 14: The Soundtrack Sync Editor 

Using the Soundtrack Sync Editor 

When the program opens, you will see a window 
displaying the different boxes, options and edit 
fields (see Figure 14). There will also be commands 
in menus at the top of the screen. The various 
program features can be used as follows: 

1. Using the Tab key: Select the edit field or 
command you want with the iTab | key or 
rQ~l-|Tab I keys. You can then enter the 
requested data or press Q to activate the 
selected command. 
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Using the Soundtrack Sync Editor 

2. Using the vertical arrow keys: Select the name 
you want in a scroll list, or a command in an 
open menu with the O keyortheO key. 

3. Using the left and right arrow keys: Position 
the cursor where you want in an edit field, or 
move from an open menu to another with the 
Q key or the Q key. 

4. Using the keyboard shortcuts: To activate the 
menu or option you want, press the dT] key 
and the highlighted letter simultaneously, or 
press the corresponding function key. To 
activate a command in an open menu, press 
the letter highlighted in its name. Special 
shortcuts for the File commands are also 
displayed in the menu. 

5. Using a mouse: To activate a menu or 
command, or select an edit field, click on it with 
the mouse. 

About the Sync Files  

The Ad Lib Soundtrack Synchronization Editor is for 
creating, editing, managing and storing .SNC — or 
Sync files containing one or several cue 
descriptions. A cue is a chosen moment of time at 
which you want one or more events to start. For 
multimedia applications, cues link sound and music 

from various audio sources with a picture file or an 
animation file. 

Once a Sync file is created, you may use the Ad Lib 
Soundtrack Playback driver or the Autodesk™ 
Animator Playback Utility to play back your multimedia 
presentation with the music and sound 
synchronized with the visuals. 

Using the Soundtrack Playback driver, sound files 
linked to given picture files automatically start to play 
when a graphic program displays the specified 
pictures. Using the Autodesk™ Animator Playback 
Utility, sound files linked to given animation files 
automatically start to play when the Autodesk™ 
Animator program displays the specified animation 
files. (Refer to the corresponding sections of this 
user guide for details concerning these two utility 
programs.) 

The Editor Boxes 

The Soundtrack Sync Editor displays three boxes at 
the upper part of the screen with information on the 
current Sync files. These are the Picture box, the 
Cue box and the Information box. 
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The Editor Boxes 

Picture Box 

This box displays the names of the pictures (.PIC, 
•PCX, .GIF, .TIF, .BMP, .WPG, etc.) or animation files 
(.FLI) and highlights the name of the one selected. 

Cue Box 

This box displays the names of the cues linked to the 
current or selected picture and highlights the name 
of the selected cue. 

The Information Box 

This box displays basic information on the Sync file 
and the current cue. 

File Name 

This field displays the name of the current 
Sync file. 

Clock 

This is a field that displays the elapsed time of 
the current picture at playback or displays the 
elapsed number of frames for the current 
animation file, depending on which picture 
synchronization mode has been specified in 
the Options menu. 

Cue Parameter Boxes 

The Soundtrack Sync Editor displays three boxes at 
the lower part of the screen showing the parameters 
of three possible audio sources: Music, Sample and 
CD audio. The following describes the parameters 
included in these boxes: 

FREE/USED 

This information indicates if the sound source 
is active or not. 

Cue Name 

This is the edit field used to enter and display 
the name of the current cue. 

Cue Time 

This is the edit field used to enter and display 
the time (after picture loading) that the current 
cue will be activated. The unit (seconds or 
frames) used for this field depends on the 
picture synchronization mode specified in the 
Options menu (Time Mode or Frame Mode). 

FREE is displayed if the sound source 
activated at the preceding cue does not play 
past the current cue for the same sound 
source. 

USED is displayed if the total length of the 
sound source activated at the preceding cue 
plays past the current cue for the same sound 
source. To remedy this, either increase the 
cue time for the USED sound source or 
decrease the Stop Time of the preceding cue 
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The Editor Boxes 

Name 

This is the edit field used to enter and display 
the name of the .RL2 file played in the Music 
source or the name of the .SMP file played in 
the Sample source. 

To enter a file name; 

1. Activate the Name edit field in the Music 
box or in the Sample box. 

2. Choose the Open... command from the 
File menu, or type the shortcut . 

A dialog box will appear listing all the files in 
the current directory (on the left) and the 
drives, directories and subdirectories (on 
the right). The path of the current 
directory will be displayed at the top of the 
dialog box. 

3. Choose a file name from this list, or open 
another directory and/or drive and choose 
a file name from that directory. 

4. Press OK to confirm your choice. 

You can also type the file name you want 
directly into the edit field. 

Track 

This is the edit field used to enter and display 
the track number played from the CD Audio 
sound source. 

start 

This is the edit field used to eriter and display 
the time (after the cue) at which the sound 
source will start to play. 

stop 

This is the edit field used to enter and display 
the time (after the cue) at which the sound 
source will stop. 

Fade In 

This is the edit field used to enter and display 
the amount of time (after Start Time) over 
which the volume of the audio source will fade 
in from 0 to the level specified in the Volume 
edit field. 

Fade Out. 

This is the edit field use to enter and display 
the amount of time (before Stop time) over 
which the volume of the audio source will fade 
out from the level specified in the Volume edit 
field to 0. 

Vo1ume 

This is the edit field used to enter and display 
the main volume of the audio source, which 
ranges from 0 to 100. 
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The Editor Boxes 

Mute 

This is a playback option that allows an audio 
source to be disabled so that one or two other 
audio sources can be listened to individually. 
Use the mouse or the Space Bar to toggle the 
check box between On and Off. 

^ NOTE: This option is not saved within the 
_Sync file._ 

Elapsed Time 

This is a field that replaces the Start edit field 
when a selected sound source is active and 
identified as USED. It indicates the time which 
has elapsed since the preceding cue. 

Remaining Time 

This is a field that replaces the Stop edit field 
when a selected sound source is active and 
identified as USED. It indicates the time left 
before the sound event finishes. 

The File Menu 

The File menu contains the commands used for 
managing your Sync files and for exiting the 
program. These are New, Open, Save, Save As... 
and Exit. 

New 

To create a new Sync file: 

• Activate the New command from the File 
menu. This command will close any open file 
and will open an empty aad untitled file. 

Open... 

To open an existing Sync file: 

1. Activate the Open... command from the File 
menu. A dialog box will open on the screen 
listing all the .SNC files in the current directory. 

2. Choose a file from this list, or open another 
directory, subdirectory and/or drive and 
choose a file from that directory. You can also 
type the file name directly into the edit field. 

3. Press OK to confirm your choice. This will 
close any open file to make room for the new 
one. 

Save 

To resave a Sync file that has been saved before: 

• Activate the Save command from the File 
menu. 
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The File Menu 

Save As... 

To save a newly created Sync file: 

1. Activate the Save As... command from the File 
menu. 

2. Enter the name you want to a maximum of 
eight characters. Since files created by 
Soundtrack Sync Editor use .SNC as their 
DOS extension, it is not necessary to include 
the .SNC part of the file name. 

3. If necessary, change the current directory, 
subdirectory and/or drive using the directory 
paths. 

4. Press OK to confirm your choice. The file will 
be saved under the name you have entered. 

Exit 

To exit the Soundtrack Sync Editor and return to 
DOS: 

1. Open the File menu. 

2. Activate the Exit command. 
Before this command is carried out, a dialog 
box will ask if you wish to save the changes 
you have made to your active file. 

The Edit Menu_ 

The Soundtrack Sync Editor allows you to modify 
fields with the edit commands found in 

the Edit menu: Undo, Cut, Copy, Paste and Clear. 

It also allows you to add and delete pictures and 
related cues or cues only, using Add Picture..., Add 
Cue, and Delete Picture and Delete Cue 
commands. 

Undo 

To undo typing or an edit text command: 

• Activate the Undo command from the Edit 
menu, or type the shortcut lait |-f^1. This will 
undo the last modification you made to the 
text. 

Cut 

To cut text in an edit field: 

1. Highlight the text you want to cut by clicking 
and dragging the mouse or using [^-(3 or 
(^-Q. 

2. Activate the Cut command from the Edit menu. 
This will remove the selected text from the edit 
field and place it in the clipboard. 
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The Edit Menu 

Copy 

To copy text in an edit field; 

1. Highlight the text you want to copy by clicking 
and dragging the mouse or using or 
(o3-Q. 

2. Activate the Copy command from the Edit 
menu. This will copy the selected text from the 
edit field and place it in the clipboard. 

Paste 

To paste copied text; 

1. Activate an edit field and position the cursor 
where you want the text to be pasted. 

2. Activate the Paste command from the Edit 
menu. This will paste the contents of the 
clipboard where the cursor is positioned in the 
edit field. 

Clear 

To clear text in an edit field; 

1. Select the text you want to clear. 

2. Activate the Clear command from the Edit 
menu. This will remove the selected text from 
the edit field without placing it in the clipboard. 

Add Picture... 

To add a picture to a Sync file; 

1. Activate the Add Picture... command from the 
Edit menu. A dialog box will appear listing all 
the files in the current directory (on the left) 
and the drives, directories and subdirectories 
(on the right). The path of the current directory 
will be displayed at the top of the dialog box. 

2. Choose a picture file from this list, or open 
another directory, subdirectory and/or drive, 
and choose a file from that directory. You can 
also type the file name directly into the dialog 
box. 

3. Press OK to confirm your choice. This will add 
the picture file to the list. 

Add Cue 

To add a new cue to a picture; 

1. Activate the Add Cue command from the Edit 
menu. This will add a new cue to the list with 
the name “UNTITLED”. 

2. To name the cue, activate the Cue Name edit 
field. The name entered must not contain 
spaces or exceed 12 characters. 
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The Edit Menu 

Delete Picture 

To delete a picture from a Sync file: 

1. Select the picture in the Picture box. 

2. Activate the Delete Picture command from the 
Edit menu. 

3. Press OK to confirm your choice. This will 
remove the selected picture from the list and 
all corresponding cues. 

Delete Cue 

To delete a cue from a picture: 

1. Select the cue in the Cue box. 

2. Activate the Delete Cue command from the 
Edit menu. 

3. Press OK to confirm your choice. This will 
remove the selected cue (and all related 
sound source information) from the list. 

The Play Menu 

The Soundtrack Sync Editor allows you to play the 
current Sync file’s three sound sources back during 
editing. The Play menu contains the playback 
commands that allow you to listen to the Sync file 

you are working on. These are Play Scenario, Play 
Picture, Play Cue, Pause, Continue and Stop. 

Play Scenario 

This command, which is available in Time mode only, 
activates all cues for the entire Sync file. 

Play Picture 

This command, which is available in Time Mode only, 
activates ail cues for the selected picture. 

Play Cue 

This command activates the selected cue. 

Pause 

This command interrupts all music and sound 
playback in progress, but the commands, options 
and edit fields are unavailable (grayed out) for editing 
until the Continue or Stop commands are activated. 

Continue 

This command restarts playback of whatever was 
interrupted at the exact place it was when the Pause 
command was activated. 



Soundtrack Synchronization Editor 

The Play Menu 

Stop 

This command stops all music and sound playback in 
progress, and the commands, options and edit fields 
become available for editing. 

The Options Menu 

Sync file playback can be done in two different 
modes depending on the graphic program used for 
the multimedia presentation. Choose either Frame 
Mode or Time Mode from the Options menu. 

Time Mode 

This option is for Sync files to be played back with 
the Soundtrack Playback Driver. It displays the Cue 
Time edit field in seconds. 

Frame Mode 

This option is for Sync files to be played back with 
the Autodesk Animator Playback utility, which plays 
back Autodesk™ Animator .FLI files. It displays the 
Cue Time edit field in frame units. 

The Help Menu 

Help... 

When you choose the Help... command from the 
Help menu, a window opens on the screen 
containing summarized information on how to 
operate the Soundtrack Synchronization Editor and 
how to use its various features. To navigate through 
the different topics, use the following buttons, which 
are displayed at the top of the window; 

Index 

Goes back to the Index page, which lists the 
various topics contained in Help. 

Back 

Goes back to the previous topic that was 
selected. 

« Browse 

Displays the previous topic in the index. 

» Browse 

Displays the next topic in the index. 

Close 

Closes the Help window. 

To get information on a given subject: 

1. With the Help window open, press the 
<lndex> button. 

2. Select the topic you want in the list. 
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The Help Menu 

3. Press OK. A page will open giving information 
on the selected topic. Use the vertical scroll 
bar or the vertical arrow keys (Q and Q) to 
access all the information on that topic. 

4. Use the buttons at the top of the window to 
navigate from one topic to another. 

About... 

When you choose the About... command from the 
Help menu, a window will open on the screen giving 
the date and version number of the Soundtrack 
Synchronization Editor. 
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Soundtrack Playback Driver 

The Soundtrack Playback driver is a memory resident 
program that synchronizes picture files with Sync 
files created using the Soundtrack Synchronization 
Editor. 

The Soundtrack Playback driver uses five memory 
resident drivers that are necessary for the playback 
of music and sampled sounds. The executable files 
for these drivers are CTRLDRV.EXE, 
WAVEDRV.EXE, FMDRV.EXE, RL2DRV.EXE and 
TIMERDRV.EXE. 

□ For more information on drivers, see “Appendix D: 
Drivers /TSRs”. 

These drivers must be loaded into memory to allow 
playback of Sync files created with the Soundtrack 
Synchronization Editor. When you use the 
Soundtrack Synchronization Editor program, you do 
not have to load these drivers independently. The 
program has a batch file that automatically loads the 
drivers. If you have not previously used the editor, 
you can load the drivers independently by typing the 
following command at the DOS prompt, which loads 
all the necessary drivers: 

drive rs 

You can then load the Soundtrack Playback driver by 
typing: 

strkdrv fileName 

Where fileName is the name of the Sync file you 
want to use for your presentation. Once the drivers 
are loaded, you can begin your graphics 
presentation. Afterwards, you may remove the 
Soundtrack Playback driver from memory by typing 
the following: 

strkdrv /r 

Once loaded, the Soundtrack Playback driver 
resides in memory where it traps the DOS commands 
issued by applications to load a file. When the 
filename of a loaded file corresponds to the one of 
the pictures defined in the Sync file, it starts running 
the sequence of cues defined for that picture. 

For example, on a presentation graphics package, 
one picture could be defined in the Soundtrack 
Synchronization Editor for each of the images that 
would be played in a presentation. The Soundtrack 
Playback driver could then trigger different audio 
events on each picture to enhance the dramatic 
effect of the presentation. 

The Soundtrack Playback driver does not limit itself 
to synchronizing with picture files and is not 
dedicated to any graphics package. It could, for 
instance, synchronize audio events to files that 
would be typed in from a batch file, or to text files 
opened by a word processor. 
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Autodesk Animator Playback Utility 

The Autodesk Animator Playback utility is a program 
that synchronizes Autodesk™ Animator .FLl files 
with Sync files created using the Soundtrack 
Synchronization Editor. 

The Autodesk Animator Playback utility uses five 
memory resident drivers that are necessary for the 
playback of music and sampled sounds. The 
executable files for these drivers are 
CTRLDRV.EXE, WAVEDRV.EXE. FMDRV.EXE, 
RL2DRV.EXE and TIMERDRV.EXE. 

□ For more information on drivers, see "Appendix D: 
Drivers / TSRs”. 

These drivers must be loaded into memory to allow 
playback of Sync files created with the Soundtrack 
Synchronization Editor. When you use the 
Soundtrack Synchronization Editor program, you do 
not have to load these drivers independently. The 
program has a batch file that automatically loads the 
drivers. If you have not previously used the editor, 
you can load the drivers independently by typing the 
following command at the DOS prompt, which loads 
all the necessary drivers; 

drive r s 

Once the drivers are loaded, you can begin your 
animation playback by typing the following: 

playanim £ ±1eName 

Where flleName is the name of the Sync file you 
want to use for your presentation. 
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Batch File Utilities 

ROL2 Playback Utility 

The ROL2 Playback utility is a small program that 
allows the user to play RL2 music files from the DOS 
command line or from a batch file. 

The format of the command running the ROL2 
Playback utility is the following: 

playrl2 fileName [/q] 

Where fileName is the name of the ROL2 music 
file (.RL2) to be played. 

The optional “/q” parameter can be used to start the 
playback of the RL2 song file and immediately 
returns control to DOS. The playback of the song will 
be taken in charge by the memory-resident ROL2 
Playback driver. 

If you enter “piayrl2” alone or with the option 
“/?” (“piayri2 /?”), the program displays help 
lines giving summarized information on program 
parameters. 

The ROL2 Playback utility uses the following five 
drivers, which have to be loaded before running it: 

• Control driver (CTRLDRV.EXE) 

• FM driver (FMDRV.EXE) 

• WavedriverWAVEDRV.EXE) 

• Timer driver (TIMERDRV.EXE) 

• ROL2 Playback driver (RL2DRV.EXE) 

Drivers can be loaded by typing the following batch 
file command at the DOS prompt: 

drivers 

Digitized Sound Playback Utility 

The Digitized Sound Playback utility is a small 
program that allows to play back digitized sound files 
(recorded in the .SMP format) from the DOS 
command line or from a batch file. 

The format of the command running the Digitized 
Sound Playback utility is the following: 

playdigi fileName t/p] [/n] 

Where fileName is the name of the digitized 
sound file (.SMP) to be played. 

Where “p" in the option “/p”, may be “c" (center), 
“r” (right), or “i” (left), indicating the stereo position 
you want for the playback of the digitized sound file. 

Where “n" in the option “/n”, may be a number from 
0 to 100, indicating the volume you want for the 
playback of the digitized sound file. 
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Batch File Utilities 

Digitized Sound Playback Utility 

If you enter “piaydigi” alone or with the option 
“/?” (“piaydigi /?”), the program displays help 
lines giving summarized information on program 
parameters. 

The Digitized Sound Playback utility uses the 
following two drivers, which have to be loaded 
before running it: 

• Control driver (CTRLDRV.EXE) 

• Wave driver (WAVEDRV.EXE) 
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Appendix A: Troubleshooting 

In this section, you will find solutions to problems you 
may encounter when installing and using the Ad Lib 
Gold Card. The following list of usual problems is 
addressed in detail afterwards. 

10. When recording with a microphone, the level 
is too low. 

11. The sound quality is poor when recording 
from a CD player or other electronic audio 
device. 

Usual Problems 12. The computer does not boot. 

1. The Setup program seems to indicate that 
the Gold card is properly installed but does 
not produce any sound. 

2. When trying to save a sample created with 
the Voice Pad program, the computer locks 
up. 

3. The serial mouse does not work properly 
with the Ad Lib card installed. 

4. The FM synthesis, MIDI or sampling does not 
work. 

5. When running software for the Gold card, 
the computer hangs. 

6. The FM synthesis and the digital sampling 
work fine but the MIDI does not work. 

7. The CD-ROM does not work. 

8. The joystick does not work. 

9. Hard disk or floppy disk does not work when 
the Gold card is present in the computer. 
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Troubleshooting 

1. Problem: 

The Setup program seems to indicate that the 
Gold card is properly installed but does not 
produce any sound. 

What could be wrong: 

• The headphones, external speaker(s) or 
stereo system are incorrectly connected. 

• The volume in the Mixer Panel is set too low. 

• There is no musical program running. 

What to do: 

• Execute the Test program. 

• Make sure that all connectors are securely 
inserted. 

✓ 

• Disconnect any external loudspeaker or 
stereo system and try the card with 
headphones. 

• Open the Mixer Panel and make sure that 
the volume is set high enough. 

• Check the Sub Mixer parameters: the FM 
and Sampling parameter settings should be 
at 100. 

• Reset the computer. 

2. Problem: 

When trying to save a sample created with the 
Voice Pad program, the computer locks up. 

What could be wrong: 

• The controller card for the hard disk is using 
the same DMA channel as the Gold card. 

What to do: 

• Run the Setup program and change the 
setting of the DMA channel. (Be aware that 
DMA channel 3 is frequently used by the 
hard drive controller card.) 

3. Problem: 

The serial mouse does not work properly with 
the Ad Lib card installed. 

What could be wrong: 

• The serial mouse is using the same interrupt 
line as the Gold card. 
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What to do: 

• To change the interrupt, run the Setup 
program and, being in the Main Seiection 
menu, select “Configure the Card and 
Drivers”. Note that COM 2, which is used 
quite often by a mouse or a modem, is 
frequently assigned to 1RQ3, and COM1 to 
IRQ4. 

4. Problem: 

The FM synthesis, MIDI or sampling does not 
work. 

What could be wrong: 

• This problem could be caused by a parallel 
printer port which is using hardware 
interrupt 7. The Ad Lib Gold card can share 
this interrupt with the parallel printer in most 
cases. However, on some PC's the parallel 
port may prevent the Gold card from 
receiving this interrupt. 

What to do: 

• Run the Setup program and, being in the 
Main Selection menu, select “Configure the 
Card and Drivers", then change interrupts. 

5. Problem: 

When running software for the Gold card, the 
computer hangs. 

What could be wrong: 

• This could be caused by an interrupt or port 
address conflict with another board. 

What to do: 

• Remove the drivers for all the boards and 
reinstall them one by one, trying the 
application every time until the conflict 
occurs. 

6. Problem 

The FM synthesis and the digital sampling 
work fine but the MIDI does not work. 

What could be wrong: 

• The software does not support the MIDI 
interface. 

• The Dual joystick selector jumpers are not 
set properly. 

• The MIDI cables are not properly connected. 

• The MIDI interface is not set to the proper 
port address or interrupt. 

69 



Appendix A 

Troubleshooting 

• The appropriate drivers are not loaded. 

What to do: 

• Make sure that the MIDI software does 
support the Gold card. If not certain, you 
should contact the manufacturer. 

• Set the Dual joystick selector jumpers in the 
“single joystick with MIDI option” position. 
Refer to the section "Getting Installed: 
Installing the Hardware" for the complete 
procedure. 

• The MIDI cables should not be inverted, the 
MIDI Out of the interface must go into the 
MIDI In of the device and vice versa. 

• If the port address or interrupts must be 
changed run the Setup program and, being 
in the Main Selection menu, select 
“Configure the Card and Drivers". 

• Make sure that the appropriate drivers are 
loaded for the MIDI application. 

Problem : 

The CD-ROM drive does not work. 

What could be wrong: 

• The cables are not properly connected. 

• The appropriate drivers are not loaded. 

• There is a DMA conflict. 

What to do: 

• Make sure that the cables are properly 
connected and that the SCSI drivers are 
loaded. Verify that the SCSI DMA channel is 
not being used by another peripheral. If no 
DMA channels are available, then you can 
address the SCSI port by interrupt. To 
select this option run the Setup program 
and, in the Main Selection menu, select 
“Configure the Card and Drivers”. 

Problem: 

The joystick does not work. 

What could be wrong: 

• The jumpers on the Gold card are improperly 
set. 
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• This will also happen when trying to use a 
joystick with another game board, or trying to 
use the game port on the Ad Lib card with 
another game card installed. 

What to do: 

• Make sure the jumpers are not missing on 
the game port switch. 

• If you want to use your former game port you 
must disable the game port on the Ad Lib 
card. Refer to the section “Installing the 
Hardware; Hardware Configuration 
Settings”. 

• Should you want to use the game port on 
the Gold card, then you should remove the 
conflicting game board or disable it if 
possible. 

9. Problem: 

Hard disk or floppy disk does not work when 
the Gold card is present in the computer. 

What could be wrong: 

• The hard disk or floppy disk is using the 
same DMA channel as the Gold card. 

What to do: 

• To change a DMA channel used by the Gold 
card run the Setup program and, being in 
the main Selection menu, select “Configure 
the Card and Drivers”. If no DMA channels 
are available for the Gold card, you can 
choose a configuration that lets you use 
drive the Sampling and SCSI by interrupt. 

10. Problem: 

When recording with a microphone, the level is 
too low. 

What could be wrong: 

• The microphone is not properly connected 
or it is connected to the wrong connector on 
the card. 

• The microphone input impedance of the 
Gold card is 1 KQ. The microphone should 
have a maximum impedance of 1 KQ if you 
do not want to lose too much input level due 
to an impedance mismatch. 

^ The Impedance is the equivalent of the elec¬ 
trical resistance in a circuit. The impedance of 
the source should be smaller than the impedance 
of the input it is feeding, in order not to reduce the 
voltage involved, thus the output level. 
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• The microphone Input level is too low. 

What to do: 

• Make sure that the microphone is correctly 
plugged into the microphone input on the 
card (No. 7 on Figures 1 and 2), and not the 
auxiliary input (No. 8) nor the audio output 
(No. 9). 

• If possible, try another microphone. 

• Go into the Mixer Panel and increase the 
Input level parameter. 

11. Problem: 

The sound quality is poor when recording from 
a CD player or other electronic audio device. 

What could be wrong: 

• The output of the audio device is plugged 
into the microphone input rather than the 
auxiliary input. 

• The Input level in the Mixer Panel is set too 
high. 

What to do: 

• Make sure that the device is correctly 
plugged into the auxiliary input on the card 
(No. 8 on Figures 1 and 2), and not the 

microphone input (No. 7) nor the audio 
output (No. 9). 

• Go into the Mixer Panel and decrease the 
Input level parameter. 

1 2. Problem: 

The computer does not boot. 

What could be wrong: 

• The programmed configuration of the 
Control chip has been lost because of a 
configuration error or a program failure. 

What to do: 

• Reset the Control chip configuration by 
proceeding as follows: 

1. Shut down the computer. 

2. Remove the computer cover. 

3. Locate the Control chip reset jumper 
(refer to Figure 1 or 2, No. 13). 

4. Unplug the Control chip reset jumper 
from the two left pins and replug it onto 
the two right pins. 

5. Replace the computer cover (optional). 
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6. Turn on the computer and load the 
Control driver by typing ctridrv. The 
program will not be loaded and will 
indicate “Card not found”. 

7. Then reset the Control chip 
configuration by typing setup /R. 

8. Shut down the computer. 

Each Ad Lib Gold card is systematically checked prior 
to shipping in order to ensure that it is free from 
technical problems. However, if you encounter a 
problem that you are not able to solve after following 
the directions in this guide, do not hesitate to call our 
technical support department. Our technical support 
number is: 418-529-6252. You will need the 
following information on hand when you call: 

9. Remove the computer cover (if 
replaced), unplug the Control chip reset 
jumper from the two right pins and 
replug it on the two left pins. 

• the serial number located on the back of your 
Ad Lib Gold card; 

• this manual. 

10. Replace the computer cover. 

11. Turn on the computer and load the 
Control driver by typing ctridrv. The 
program will now been normally loaded 
in memory. 

12. This procedure restores the Control chip 
default configuration, which is: no DMA, 

card address 388H, and IRQ 7-0. If you 
wish change this default configuration, 
run the Setup program by typing 
setup. 
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Appendix B: List of Installed Files 

The Ad Lib Gold Software included with the program 
disks contains, when decompressed and installed, 
several files related to the utilization of the Gold card: 
drivers, application programs, music, sounds, and 
other various files. These files are: 

• README.TXT 
This file is not compressed on the program 
disk. It contains information on the latest 
program updates, if there are any, and any 
other pertinent information. 

• CTRLDRV.EXE 
This file is not compressed on the program 
disk, it contains the Ad Lib Gold Control chip 
driver. This low level driver is used by other 
programs, such as the Setup program, to 
implement: DMA channel & interrupt number 
select: sampling source select; sampling gain 
and input filter; microphone input gain; 
sampling output filtering and volume & tone 
control; mixing control; card localization setup 
and ID code reading; saving registers in non 
volatile memory. 

• SETUPGLD.EXE 
This file is not compressed on the program 
disk. It contains the Setup program. This 
program enables you to install the drivers and 
all associated programs, to configure your Ad 
Lib Gold card and to change the hot keys used 
by Mixer Panel and ROL2 Playback TSRs. 

• SETUP.BAT 
This file is not compressed on the diskette. It 
contains the DOS command sequence which 
loads the necessary drivers and calls the 
Setup Program. 

Drivers and TSRs 

• FMDRV.EXE 
This file contains the FM driver. This low level 
driver implements: preset change; note on; 
note off; pitch bend; volume and stereo 
positioning. 

• WAVEDRV.EXE 
This file contains the Wave driver. This low 
level driver implements; recording and 
playback of samples by DMA and interrupt. 

• TIMERDRV.EXE 
This file contains the Timer driver. This low 
level driver implements: the five timers of the 
Yamaha Magic Chip Set. 

• MIDIDRV.EXE 
This file contains the MIDI driver. This low level 
driver implements: MIDI In and Out serial port 
control. 
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• RL2DRV.EXE 
This file contains the ROL2 Playback driver. 
This low level TSR driver implements: playback 
of the .RL2 music files and user control 
commands. 

• MIXER.EXE 
This file contains the Mixer Panel TSR. This 
memory resident application allows for the 
control of the programmable volume and tone 
control, mixer settings, and surround features. 

• ALARMDRV.EXE 
This file contains the Alarm driver. This low 
level driver implements: playback of Voice Pad 
alarms. 

. • SYNCDRV.EXE 
This file contains the Soundtrack Playback 
driver. This low level driver implements: 
playback of Soundtrack Synchronization 
Editor Sync files (.SNC). 

• SOUND.COM 
This file is the sound driver for the original 
Ad Lib Music Synthesizer Card. This program 
might be necessary in some cases for running 
programs compatible with the original Ad Lib 
card. 

Application Programs (Executables) 

• TESTGOLD.EXE 
This file contains the Ad Lib Gold Test 
Program. This program enables you to verify 
that the Gold card is functioning properly in all 
of its different components. 

• JUKEG.EXE 
This file contains the executable code of Juke 
Box Gold. 

• VPAD.EXE 
This file contains the executable code of Voice 
Pad. 

• SNDTRACK.EXE 
This file contains the executable code of 
Soundtrack Synchronization Editor. 

• ANIMGLD.EXE 
This file contains the executable code of 
Autodesk Animator Playback utility. 

• PLAYRL2.EXE 
This file contains the executable code of 
ROL2 Playback utility. 

• PLjAYDIGI.EXE 
This file contains the executable code of 
Digitized Sound Playback utility. 
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Batch Files 

• TEST.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Test Program. 

• JUKEGOLD.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Juke Box Gold Music Playback 
Program. 

• VOICEPAD.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Voice Pad Record and Playback 
Program. 

• STRACKED.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Soundtrack Synchronization 
Editor. 

• STRKDRV.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Soundtrack Playback driver. 

• PLAYANIM.BAT 
This file contains the DOS command 
sequence which loads the necessary drivers 
and calls the Autodesk Animator Playback 
utility. 

• DRIVERS.BAT 
This file contains the DOS command 
sequence which loads all drivers necessary to 
mn Ad Lib Gold programs. 

Other Files 

• *.RL2 
The “.RL2” files contain the pieces of music 
that will be played with the Juke Box Gold. 

. *.SMP 
The “.SMP” files contain the PCM digitized 
sounds. TESTGLD1 .SMP is the sound file 
that will be used by the Test program. 

. SAMPLES.BNK 
This file contains the ADPCM digitized 
instrument sounds. 

• SAMPLBNK.EQU 
This file contains a translation table of digitized 
instrument sound names, which is used by the 
ROL2 Playback driver. 
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• FMSOUND.BNK 
This fiie contains the FM synthesized 
instrument sounds compatible with the OPL3 
FM synthesis chip. 

Fiies Created by Programs 

• *.PAD 
A “.PAD” fiie is created for each voice note you 
save in the Voice Pad program to store the 
digitized recording. 

• DIRVOICE.PAD 
This is a bank fiie created the first time you 
save a voice note in the Voice Pad program to 
store information about the voice notes. 

• JUKEBOX.DAT 
This file is created the first time you make a 
selection of songs in the Juke Box Gold 
program, permitting not to iose your seiection 
even after rebooting the computer. 

• *.SNC 
A “.SNC” fiie is created for each Sync file you 
save in the Soundtrack Synchronization Editor 
program. SYNCDEMO.SNC is an example of a 
Sync file created with this program. 
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Setup Program 

"An error has occurred, while 

modifying the file. " 

The Setup program was unable to complete the 
modification of the AUTOEXEC.BAT or 
CONFIG.SYS files. 

□ See “Software Installation and Configuration”. 

Test Program 

"Error loading sample." 

Test program was able to open the sample but found 
that the contents have been corrupted. Using the 
Setup program, reinstall the TESTGLD1 .SMP file 
from your original diskette. 

"Error playing sample." 

Test program is unable to play the sample. The 
memory may be full. Check the configuration of the 
card. 

"Error recording sample." 

Test program is unable to record the sample. The 
memory may be full. Check the configuration of the 
card. 

"Problem 

chip ” 

with TIMER 1 on the FM 

"Problem 

chip” 

with TIMER 2 on the FM 

"Problem with TIMER 1 and 2 in 

concurrent mode on the FM chip" 

"Problem 

chip" 

with TIMER 0 on the MMA 

"Problem 

chip" 

with TIMER 1 on the MMA 

"Problem 

chip" 

with TIMER 2 on the MMA 

"Problem with TIMER 0, 1 and 2 in 

concurrent mode on the MMA chip" 

All these messages state that the Test program 
detected a Timer problem. First check the 
configuration of the card. If the problem persists, 
reboot the computer, reload the Test program and 
try again. 

Juke Box Gold Program 

As the error messages are the same as for the ROL2 
Playback driver, see this section below. 
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Error Messages 

Voice Pad Program 

"There is no DIRVOICE.PAD file. 

This file is created after the 

first recording. No alarm will 

be played." 

This message appears at the loading when the 
program does not find the DIRVOICE.PAD file, which 
is a collection of voice notes. If you want voice note 
alarms be played, the DIRVOICE.PAD bank file must 
be in the same directory as the Voice Pad program. If 
there Is no DIRVOICE.PAD file present, the first time 
you save a voice note, the program will automatically 
create the DIRVOICE.PAD file to store your voice 
note. 

"File handling error" 

The Voice Pad program cannot handle the file 
because its format is not compatible with the version 
you are using. 

"Out of memory" 

Voice Pad cannot function because the memory 
space (RAM) is insufficient. The space required by 
the program is greater than the space available. 

"Wave driver error" 

The Voice Pad program cannot function because 
the Wave driver does not respond. 

"Error when opening" 

The program cannot load the file, because a reading 
error occurred. 

"Disk error" 

An error occurred while writing or reading the file on 
the disk. Simply trying again will be sufficient in many 
cases to make the same operation work normally. If 
the problem persists and the same message keeps 
appearing, refer to your DOS manual for more details 
on possible solutions. 

"A problem occurred, with the 

alarm manager. No alarm will be 

played." 

The Voice Pad alarm manager cannot function 
because Alarm driver (ALARMDRV.EXE) is not 
loaded in memory or does not respond. 

"Unable to save. The disk you are 

saving to is probably full." 

There is not enough space on the disk to save the 
file. Clean up your disk by deleting all unnecessary 
files and try again. 
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Error Messages 

"Error in date alarm. The voice 

note is not saved. Use this 

format: yy/mm/dd . " 

The program cannot store the voice note because 
the date alarm specified does not correspond to the 
required format. Correct the date alarm format as 
requested before saving the file. 

"Error in time alarm. The voice 

note is not saved. Use this 

format: hh : mm . " 

The program cannot store the voice note because 
the time alarm specified does not correspond to the 
required format. Correct the time alarm format as 
requested before saving the file. 

"Error in snooze alarm. The voice 

note is not saved. Use this 

format: mm . " 
✓ 

The program cannot store the voice note because 
the snooze specified does not correspond to the 
required format. Correct the snooze format as 
requested before saving the file. 

"There is nothing to save." 

The program does not save the opened file because 
there have been no changes or modifications 
entered since the last save, or because it is an empty 
file. 

"Last voice note was not saved. 

Do you really want to exit?" 

The program warns you that there were changes or 
modifications entered since the last save and asks if 
you want to save them before exiting. 

Soundtrack Synchronization Editor 

"Picture name already exists." 

This message appears when you type in the Add 
Picture... dialog box a picture name that is already 
included in the picture list. The program cannot 
make a Sync file that refers to the same picture twice 
in the picture list. 

"Memory full." 

Soundtrack Synchronization Editor cannot function 
because the memory space (RAM) is insufficient. 
The space required by the program is greater than 
the space available. 

ROL2 Playback Driver 

"Program already installed." 

The ROL2 Playback driver wiH not be installed 
because it has been previously installed in memory, 
probably within a program batch file. 
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"No more user 
available.” 

interrupts 

there are no <fofc! ^ ^ function because 
holn!, ®°^3re interrupts available, they are 
being used by other programs 

"Cannot remove as driver not 
previously installed.” 

The ROL2 Playback driver will not be removed 
because it was not installed in memory. 

'Unable to remove as other 
software has been loaded after 
this one.” 

The ROL2 Playback driver will not be removed 
because there are one or more drivers/TSRs that 
have been installed after it. In the list of drivers/TSRs 
installed, only the last one can be removed. 

"Missing driver (s) or 
SAMPLES.BNK" 

The ROL2 Playback driver cannot be loaded 
because an underlying driver necessary to its 
functioning cannot be found in memory. 

OR 

The ROL2 Playback driver cannot be loaded 
because the SAMPLES.BNK file cannot be found in 
the same directory or the directories specified by the 
GOLDPATH environment variable. 
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Other Drivers 

" XXX already install®*^' 
The driver xxxvj\\\ not be installed because it has 
been previously installed in memory, probably within 

a program batch file. 

”Gold Card, not found. 

Driver cannot identify the Gold card. Reset the 
configuration by typing: setup /R- 

"Control Driver not found 

(CTRLDRV.EXE)." 
The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type ctridrv and try again. 

"Unable to link with Control 
Driver (CTRLDRV.EXE) 
A program cannot function because the driver does 
not respond. Reboot the computer and try again. 

"Timer Driver not found 

(TIMERDRV.EXE) . " 

The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type timerdrv and try again. 



Appendix C 

Error Messages 

"Unable to link with Timer Driver 
(TIMERDRV.EXE) 

A program cannot function because the driver does 
not respond. Reboot the computer and try again. 

"MIDI Driver not found. 
(MIDIDRV.EXE)." 

The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type mididrv and try again. 

"Unable to link with MIDI Driver 
(MIDIDRV.EXE) 

A program cannot function because the driver does 
not respond. Reboot the computer and try again. 

"FM Driver not found 
( FMDRV.EXE) . " 

The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type fmdrv and try again. 

"Unable to link with FM Driver 
(E;MDRV . EXE) . " 
A program cannot function because the driver does 
not respond. Reboot the computer and try again. 

"Wave Driver not found 
(WAVEDRV.EXE)." 
The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type wavedrv and try again. 

"Unable to link with Wave Driver 

(WAVEDRV.EXE)." 
A program cannot function because the driver does 
not respond. Reboot the computer and try again. 

"Playback Driver not found 

(RL2DRV.EXE)." 
The driver, called separately or by a program batch 
file, cannot be loaded because the file cannot be 
found in memory. Type ri2drv and try again. 
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Appendix D: Drivers/TSRs 

Ad Lib Gold applications, like Juke Box, Voice Pad, 
as well as third party applications, use memory 
resident programs as resources. These programs 
are referred to as drivers or TSRs (Terminate and 
Stay Resident). 

We usually refer to memory resident programs as 
drivers when they work in the background as low- 
end resources for other programs (i.e. without a user 
interface). Although any memory resident program 
may also be called a TSR program, we usually keep 
this generic name for programs designed to be 
controlled by the end user, whether using specific 
key stroke combinations, as with the ROL2 Playback 
utility (PLAYRL2.EXE), or through a pop-up window, 
as in the Ad Lib Gold Mixer Panel (MIXER.EXE). 

TSRs and drivers are loaded in memory much like a 
standard executable program; whether their name is 
typed in or appears in a batch file. Once loaded the 
TSRs and drivers remain in memory, ready to offer 
services to the end user or to the application that 
requires them. Being independent from the 
applications, TSR and drivers are a simple method of 
providing hardware independence to applications 
and to ease software upgrades. 

When loaded, a TSR or a driver usually prints its 
name and version number to the screen. If a driver 
has already been loaded once, it will indicate that it is 
already present in memory, and will not load a 

second time. 

A message indicating that the TSR or the driver is 
already loaded is a normal message, and should be 
no cause for alarm. 

While most TSRs are simply low-end resources 
working in the background without any user 
interface, they can also be designed to be controlled 
with specific key stroke combination, like the ROL2 
Playback utility (PLAYRL2.EXE), or through a pop¬ 
up window like the Ad Lib Gold Mixer Panel 
(MIXER.EXE). 

The drivers supplied with the Ad Lib Gold card are 
the following: 

CTRLDRV.EXE 

Control Driver: Offers services related to the 
basic configuration of the Gold Card, and to 
the Gold card mixer. 

It also acts as the manager of all other Ad Lib 
Gold drivers in memory. For this reason, the 
Control Driver should always be the first driver 
to be loaded in memory, as is the case in the 
provided batch files. 

FMDRV.EXE 

FM Driver: Provides applications with services 
related to the generation of FM sounds on the 
Gold card. 
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Drivers / TSRs 

WAVEDRV.EXE 

Wave Driver; Provides applications with 
services that allow the recording and playback 
of digitized sounds. 

TIMERDRV.EXE 
Timer Driver; Gives access to the high- 
resolution hardware timers available on the 
Gold card. These timers may be used, for 
example, by games and music sequencing 
programs. 

MIDIDRV.EXE 
MIDI Driver; Can be used used by applications 
to read and write data to and from the MIDI port. 

ALARMDRV.EXE 
Alarm Driver; Used to play back alarms of voice 
notes created by the Voice Pad program. 

RL2DRV.EXE 

ROL2 Playback Driver; Is used by applications 
to control the playback of Ad Lib music files 
(.RL2 files). It is a powerful utility that uses the 
services of the other underlying drivers to 
simplify the task of integrating music and 
digitized sound to applications. It is used, for 
example, by the Ad Lib Juke Box Gold 
program. (See below for the options 
supported with this driver.) 

SYNCDRV.EXE 

The Soundtrack Playback driver is used to 
synchronize files loaded by a third-party 
application with audio events, according to the 
information contained the Soundtrack 
Synchronization Editor Sync files (.SNC). 

Applications can use one or more of these drivers. 
To make sure that the drivers are properly loaded 
when calling an application, each application is 
provided with a batch file that loads the appropriate 
drivers. 

The following batch file command loads all drivers 
necessary to run Ad Lib Gold programs; 

drive r s 

ROL2 Playback Driver Options 

You normally do not have to load the ROL2 Playback 
driver independently to run Juke Box Gold. The 
application has a batch file that automatically loads 
the RL2DRV.EXE file. But if it is necessary for some 
reason, the driver can be loaded and removed by 
typing the following commands and options at the 
DOS prompt; 

rl2 drv 
Loads the ROL2 Playback driver into the 
computer's memory (RAM). 
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rl2dLrv /r 

This option removes the ROL2 Playback driver 
from the computer's memory when it is 
installed but you do not wish to use it. Once 
this command is entered, the program will 
display a message indicating that the ROL2 
Playback driver has been removed and is no 
longer loaded. 

rl2d.rv /vn 

This option disables the specified sampling 
voice “n", which can be “i” or “2”. Use two 
options consecutively, “/vi /v2", to 
disable the two sampling voices. 

The playback of sampled voices consumes a 
lot of computer resources. On slower PCs, or 
when the ROL2 Playback driver is used in 
conjunction with more demanding 
applications, this option can be used to insure 
a proper functioning of all parts involved. 

rl2d.rv /spath 

This option specifies to the driver where it can 
find the data files used for song files. You can 
specify a path if the data files are not in the 
current directory and are not in the directories 
specified by the GOLDPATH environment 
variable. 
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Appendix E: Connecting Internal PC Speaker 

! WARNING: Do not attempt to connect the 

PC internal speaker to the Gold card 
yourself, unless you are sure you have 
the appropriate technical capabilities. If 
you are not sure of your capabilities, you 
may damage your computer or your Gold 
card. Ad Lib Inc. and Its distributors will 
not be liable for such damages. 

The Ad Lib Gold card has an internal PC speaker 
connector. You can use it to connect the signal of 
the PC’s internal speaker directly to the Ad Lib Gold 
card so that it is mixed with the other audb signals on 
the card and can be heard through the headphones 
or speakers. We strongly recommend that you ask 
an experienced technician to connect the PC 
internal speaker for you. 

The procedure consists of the following steps: 

1. Remove the computer cover, following the 
steps stated in the “Getting Installed: Installing 
the Hardware” section. 

2. Unplug the cable connected to the internal PC 
speaker. 

3. Consulting your motherboard user’s manual, 
identify the GND (ground) and speaker drive 
out pins on the motherboard. 

4. Locate the PC speaker connector (“Molex” 
type) on the Ad Lib Gold card (refer to No. 3 on 
Figures 1 and 2). Then identify the GND pin, 
which is the No. 2 (the left one), and the 
speaker drive out pin, which is the No.1 (the 
right one). 

5. Connect a wire (not supplied with the Gold 
card) from the rrwtherboard GND pin to the left 
pin of the PC speaker connector on the Gold 
card. 

6. Connect another wire from the motherboard 
speaker drive out pin to the right pin of the PC 
speaker connector on the Gold card. 

7. Replace the computer cover, and reconnect 
the power cord and other cables. 
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Appendix F: Technical Specifications 

This section is a general reference guide that details 
the capabilities of the Ad Lib Gold card and the 
parameter values of its different components. 

FM Synthesis 

FM Synthesizer Chip YMF262 

Number of FM Voices When Used in Mono 20 

Number of FM Voices When Used in Stereo 20 

Two Operator FM Synthesis V 

Four Operator FM Synthesis V 

Number of FM Waveforms 8 

Wait Time Between Chip Writes 0.28 ps 

FMDAC 16 bits 

FM Dynamic Range 96 dB 

Sampling 

Sampling Chip YMZ263 

Sampling DAC (Sampling Resolution) 12 bits 

Sampling Dynamic Range 72 dB 

PCM Data Accepted 16,12 and 8 bits 

Sampling Record and Playback Channels 2 

Sampling Rates (Stereo & Mono) 44.1 KHz 
22.05 KHz 

11.025 KHz 
7.35 KHz 

5.5125 KHz 

Digitized Sound Data Format PCM & ADPCM 

Hardware Compression/Decompression 3 to 1 

Simultaneous Use of two DMA Channels V 

Sampling FIFO Buffer 2 x 128 Bytes 

Programmable Interrupts V 

Interrupt Conditions 8 choices 

Variable Antialiasing Filter V 

Double Oversampling Digital Filters V 

Double Undersampling Digital Filters V 

Mixer 

On-Board Analog Stereo Mixer 8 entries 

Accepts CD-Audio (RedBook) Input V 

Volume Control on Each Source 42 dB 
128 steps 

Stereo Output Power Amplifier 1.2 Watt RMS in 8f2 

Output Volume Range 80 dB 
2 dB steps 
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Technical Specifications 

Bass and Treble Range ±12 dB Programmable On-Board Chip Select V 

Programmable Gain for Audio Input V 

Input Impedance 1 KQ Registers 

Input Sensitivity 1-100 mV ID Code Available V 

Directly Accessible Control Registers V 
Interfaces Readable Control Registers V 

MIDI Interface Ports In, Out & Thru Registers Stored in Non-volatile Memory V 

Simultaneous MIDI In & Out V Non-volatile Memory (EEPROM) 256 bit 

MIDI FIFO Buffer 16 byte 

Joystick Port V Option Connectors 

SCSI CD-ROM Interface (Gold 2000) 1.5 MBytes/sec Connectors for Surround Sound Option V 
Individual Timers 5 Connector for Telephone Option V 

Connector for PC Speaker V 
Programmable Parameters Connector for Internal Stereo Aux. Input V 

Programmable Output Volume Control V Connector for SCSI (Model 2000) V 

Programmable Output Treble Control V Connector for SCSI Option (Model 1000) V 

Programmable Output Bass Control V 

Programmable Gain for Mike & Aux. Input V 

Programmable Card Localisation 128 

Programmable DMA Channel Selection V 

Programmable Interrupt Selection V 
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